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1 Introduction

1.

Introduction

1.1

Add-on Module FOUNDATION Pro

Designing single foundations is part of the standard tasks faced by structural engineers in their
day-to-day work. The number of designs which must be performed for the ultimate as well as
the serviceability limit state requires powerful software in order to design single foundations
efficiently.
The add-on module FOUNDATION Pro fulfils these conditions offering its users the possibility
to design single foundations economically and to document the results in a verifiable form.
FOUNDATION Pro performs the design for the following foundation types:
• Bucket foundation with smooth or rough bucket sides
• Foundation plate
• Block foundation with smooth or rough bucket sides
The offered foundation types cover a multitude of foundation layouts used in the construction
practice.
The reinforced concrete design of the foundations is performed according to the standard
EN 1992-1-1:2004 + AC:2010 [1]
The geotechnical designs are performed according to the following standard:
EN 1997-1 [2]
If desired, it is possible to deactivate the individual types of design specifically.
The load cases and combinations used for the design with FOUNDATION Pro must be created
in the main program RSTAB. After the calculation, the support reactions of the load cases and
combinations are available in the add-on module. Furthermore, it is possible to deactivate individual support reactions for the design of the foundation.
The results of the foundation design can be documented in the printout report of RSTAB. Moreover, FOUNDATION Pro provides reinforcement drawings which can also be exported to a DXF
document.
We hope you will enjoy working with FOUNDATION Pro.

Your DLUBAL Team
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1.2

FOUNDATION Pro Team

The following people were involved in the development of FOUNDATION Pro:

Program coordination
Dipl.-Ing. Georg Dlubal
Dipl.-Ing. (FH) Alexander Meierhofer

Dipl.-Ing. (FH) Younes El Frem

Programming
Ing. Michal Balvon
Ing. Václav Rek

Ing. Jakub Lefner
Ondřej Musil

Program design, dialog figures, and icons
Dipl.-Ing. Georg Dlubal

MgA. Robert Kolouch

Program supervision
Ing. Jarmila Zdráhal
Dipl.-Ing. (FH) Alexander Meierhofer

Dipl.-Ing. (FH) Paul Kieloch

Localization and manual
Ing. Fabio Borriello
Ing. Dmitry Bystrov
Eng.º Rafael Duarte
Ing. Lara Caballero Freyer
Ing. Alessandra Grosso, Ph.D.
Ing. Ladislav Kábrt
Dipl.-Ing. (FH) Paul Kieloch
Eng.º Nilton Lopes Fernandes

Ing. Téc. José Martínez Hernández
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BSc Eng Chelsea Prokop
Ing. Michaela Prokopová
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1 Introduction

1.3

Using the Manual

Topics like installation, graphical user interface, results evaluation, and printout are described
in the manual of the main program RSTAB. The present manual focuses on typical features of
the add-on module FOUNDATION Pro.
The description of the program follows the sequence and structure of the module's input and
results windows. The text of the manual shows the described buttons in square brackets, for
example [Edit]. The buttons are also shown in the left margin. The expressions that appear in
dialog boxes, windows, and menus are set in italics to clarify the explanations.
At the end of the manual, you find the index. If you still cannot find what you are looking for,
please check our website www.dlubal.com where you can go through the FAQ pages and find
a solution by using various filter criteria.
We have also written some blog reports and posts in social media about how to work with
FOUNDATION Pro. There, you can find useful information for the program handling. To open
the Dlubal blog, go to https://www.dlubal.de/blog/en/. Use the 'Search' function on the top
right to find specific articles about FOUNDATION Pro.

1.4

Open the Add-on Module FOUNDATION Pro

RSTAB provides the following options to start the add-on module FOUNDATION Pro.

Menu
To open the add-on module, select
Add-on Modules → Foundations → FOUNDATION Pro.

Figure 1.1: Menu Add-on Modules → Foundations → FOUNDATION Pro

Program FOUNDATION Pro © 2014 Dlubal Software GmbH
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Navigator
Alternatively, you can start the add-on module in the Data navigator by clicking
Add-on Modules → FOUNDATION Pro.

Figure 1.2: Data navigator: Add-on Modules → FOUNDATION Pro

You have the possibility to store add-on modules as Favorites in the Data navigator: Right-click
the relevant module entry to open its shortcut menu. Then, select the option Favorite.

Figure 1.3: Defining FOUNDATION Pro as favorite add-on module

FOUNDATION Pro cannot be started directly as a stand-alone program. The add-on module is
integrated in the main program RSTAB, which means that the model with the corresponding
foundation must be opened in RSTAB before you start FOUNDATION Pro.

8
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2.

Input Data

2.1

General Data

Figure 2.1: Window 1.1 General Data

After starting FOUNDATION Pro, a new window opens. On the left, you can see the navigator
displaying all module windows that can be selected.
Above, you find a list with already available design cases. To open the list, click the arrow button []. Then, you can select a design case by clicking the corresponding entry.
Below the title bar, you find the menus File, Settings, and Help.
In the File menu, you find the commands to create a new design case or to delete, rename or
copy an existing case (see Chapter 7.1, page 62). Moreover, you have the possibility to save the
file and to export the geometry of the foundation as well as the reinforcement drawings.
For more information about exporting results, see Chapter 7.4 Export of Results.
The [Details] button is available in each input window of FOUNDATION Pro. Clicking the button enables access to the Details dialog box where different settings can be defined for the
calculation.
The Details dialog box is described in Chapter 3.1 on page 28.
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Design case / Foundation No.
In FOUNDATION Pro, you have to distinguish between the design case (FOUNDATION Pro case)
and the foundation.
A design case is the case to which you can assign as many foundations as you want. When you
start a new design case, a foundation is created by default (Foundation No. 1). All nodal supports of the model are allocated to this foundation.
As shown in Figure 2.1, a foundation with the foundation number 1 was created for case CA1.
The checkbox for All nodal supports in the window section below is selected. A bucket foundation with smooth bucket sides will be created for nodes number 5 and 9-14.
In case of large models with different foundation shapes and column dimensions, it can be
necessary to analyze several foundations in one case. In the current design case, you can define a new foundation where it is possible to change the foundation type or select an eccentric
column arrangement.

Foundation
The number of the current foundation is displayed in the list.

Figure 2.2: Window section Foundation

You can use the three buttons to the right to create a [New] foundation, to [Copy] or [Delete] a
foundation.
Furthermore, it is possible to assign a Description.

At Nodes No.
This window section manages the numbers of the nodes for which the current foundation parameters are applied.

Figure 2.3: Window section At Nodes No.

With the [Select] button [] you can select the relevant nodes also in the RSTAB graphic. The
dialog box Multiple Selection opens. Already selected support nodes can be deleted by clicking
the [Clear] button.

Figure 2.4: Selecting the nodes in RSTAB

10
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Alternatively, it is possible to select the checkbox All nodal supports. Then, FOUNDATION Pro
will assign to the foundation all nodes on which a nodal support is available.

Figure 2.5: Selection of all nodes having support properties

A node can be selected only once in a FOUNDATION Pro case. To design another foundation with the same node number, you have to create a new design case.
When copying a foundation (e.g. foundation No. 1), all support nodes which have not been selected for the first foundation will be assigned automatically to the new foundation and set for
the design.

According to
The following standards are available for the design in FOUNDATION Pro:
•

Reinforced concrete design according to EN 1992-1-1:2004/AC:2010

•

Geotechnical analyses according to EN 1997-1

The governing National Annex can be selected in a list.

Figure 2.6: Window section According to

Use the [Edit] button to open a dialog box where you can check the parameters of the currently selected annex. The [Nat. Annex] button at the bottom of the module window has the same
function.
With the [New] button you can create a user-defined National Annex.
Find more information about the available standards and annexes in Chapter 7.3 on page 65.
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Type of Foundation
Here, you specify the layout of the foundation. You can see it dynamically displayed in the
graphic to the right.

Figure 2.7: Window section Type of Foundation

The following foundation types can be selected:
Bucket foundation

Foundation plate

Block foundation

Table 2.1: Foundation types

The bucket and block foundations are further differentiated with regard to the surface texture
of the inner bucket sides which can be smooth or rough.

Allowable Soil Pressure
In this window section, you can choose between two or three (DIN setting) input options.

Figure 2.8: Window section Allowable Soil Pressure

The characteristic soil pressure can be User-defined. It is used for the contact stress analysis
σEd ≤ σRd = σRk / γR,v according to EN 1997-1.
Another possibility is to perform the design of the allowable soil pressure by the Bearing capacity according to EN 1997-1 annex D.
If the National Annex for Germany is set, you can also determine the allowable soil pressures
by means of the tables For standard case according to DIN EN 1997-1, A6.10. First, you have to
specify if the soil is cohesive or non-cohesive. Then, you can use the [Details] button to open a
dialog box where the soil group is determined (see picture below).

12
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Figure 2.9: Dialog box Allowable Soil Pressure for Standard Case 'Cohesive Soil'

The dialog box facilitates the determination of the allowable soil pressure. The relevant soil
pressure is determined depending on the foundation embedment depth from the table.
Here, FOUNDATION Pro interpolates the value of the allowable soil pressure (σR,d) for the foundation's effective embedment depth d on the basis of the intermediate values of the standard
case table.
In module window 2.2 Governing Design Criteria, the table value of the allowable soil pressure
applied to the ground failure analysis according to Table A 6.6 (al σTab) is shown.

Settings for Sliding
In this window section, you can decide if you want to consider the passive earth resistance according to EN 1997-1 annex C for the design of the foundation.

Figure 2.10: Window section Settings for Sliding

When the check box is selected, further settings for the sliding resistance design are enabled in
the dialog box Design Parameters for Foundation Plate which is available in module window 1.2
(see Figure 2.18, page 17).

Soil Parameters
This window section offers settings for the soil conditions. In the list, you can choose drained
or undrained conditions of the soil.

Figure 2.11: Window section Soil Parameters

Click the [Details] button next to the selection box to open a dialog box used for defining the
soil parameters. The appearance of the dialog box depends on the selected subsoil conditions
(see following figures).
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Drained conditions

Figure 2.12: Dialog box Details for Earth Resistance for drained subsoil conditions

In the Details for Earth Resistance dialog box, you can define the Angle of wall friction φk as well
as the Angle of soil friction δs,d.
With the options available in the Embedment Depth of Foundation section you decide whether
the depth is determined from the plate thickness t and the earth covering e based on the design
of the foundation in the ultimate limit state or whether the user-defined value d is to be applied.

Undrained conditions

Figure 2.13: Dialog box Details for Earth Resistance for undrained subsoil conditions

In this dialog box, you have to enter the value of the Cohesion in undrained state cuk.
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2.2

Geometry

Figure 2.14: Window 1.2 Geometry

2.2.1

Column

This window section manages the parameters of the column.

Figure 2.15: Window section Column - definition of column dimensions and layout

Standard column dimensions are set by default in both text boxes cx and cy. They can be adjusted to the actual conditions. Use the button [Import Column Dimensions from RSTAB] to
import the dimensions of the column cross-section from the RSTAB model.
With the button [Import Column Dimensions from Selected Cross-Section] you can also select
another cross-section created in RSTAB.
When the check box for Eccentric layout is selected, you can offset the center point of the column relative to the center point of the plate. The eccentricity must be defined in a separate dialog box (see following figure) that you can access by clicking the [Edit] button to the right.
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Figure 2.16: Dialog box Eccentric Layout of Column

The Column Eccentricity can be defined with four text boxes. The first two boxes describe the
distance of the column center from the centroid of the foundation plate.
Please pay attention to the sign: For example, if you want to arrange the column with
an offset to the left, the distance ex must be entered positively because the centroid of
the foundation plate lies in the positive x-direction seen from the center of the column
(coordinate system of support).
In the two boxes below, you enter the distances of the bucket opening from the edges of the
foundation plate. These values always have positive signs.
The interactive dialog graphic shows the top view of the foundation including the coordinate
system of support. The graphic is useful for defining the column eccentricity. Use the [Info] button to switch between the interactive graphical representation and the sketch of the system.

2.2.2

Foundation Plate

Figure 2.17: Defining or rating the foundation plate dimensions

In this window section, you decide if you want to specify the dimensions of the foundation
plate manually or if you want the program to rate them.

Define dimensions
When the manual definition is selected, the three text boxes to the right are enabled. You can
enter the side lengths and the thickness of the foundation plate.
The minimum dimensions specified in Chapter 3.2 must be observed!
If the foundation plate has been dimensioned iteratively by the program (see below), it is possible to import the determined dimensions with the [Import] button. Then, you can adjust the
values, for example in order to use rounded dimensions.

Rate
FOUNDATION Pro determines the dimensions of the foundation plate according to the requirements resulting from the soil-mechanical analyses.
Click the [Edit] button to access the parameters needed for dimensioning the foundation plate.
The dialog box Design Parameters for Foundation Plate (see the following page) opens.
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Figure 2.18: Dialog box Design Parameters for Foundation Plate

Settings for Geotechnical Design
You have to decide which Dimensions of foundation plate at start of iteration you want to use
(minimum dimensions or user-defined initial values).
The Criteria for increasing the x and y dimensions control the way how the parameters are
changed during the dimensioning in the iteration steps. Several options are available for selection in the list (see figure shown on the left). Furthermore, the dimensioning takes account of a
user-defined limit ratio between both side lengths.
The following Criteria for increasing the z dimension can be selected for the determination of
the plate thickness.
• No increase
• Height of earth covering
• Thickness of foundation plate
The option Thickness of foundation plate offers a list with different possibilities for the dimensioning. In this case, a user-defined limit ratio between the plate thickness and the minimum
side length is also taken into account.
The dimensioning to be carried out by the program can also Increase the earth covering if the
criterion for the frost-free embedment is not fulfilled. Here, you have to specify the earth covering c at the beginning of the iteration and the embedment depth df.
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Settings for Sliding Resistance Design
To access this dialog section, the check box Consider passive earth resistance according to
EN 1997-1 Annex C must be selected (see Figure 2.10, page 13).
With the first two dimensioning options you increase the Side of the foundation or the Plate
thickness iteratively until the design of the sliding resistance is fulfilled. When the third option
is activated, it is possible to specify a user-defined ratio for increasing the foundation side in relation to the foundation thickness. If the length of the foundation side is in increased within an
iteration step, for example by one centimeter, the plate thickness will be increased as well by
one centimeter when a ratio of 1:1 is set.

Settings for Concrete Design
Here, you enter the Increasing step Δt to increase the plate thickness so that the reinforced
concrete designs will be fulfilled.

Settings for Iteration
The number of iteration steps is used to set an upper limit for possible calculation runs.

2.2.3

Bucket

Figure 2.19: Window section Bucket

You can decide if you want to specify the dimensions of the bucket manually, or if the program
rates them.

Define dimensions
When the manual definition is selected, you can access the text boxes to the right. Use them to
describe the bucket geometry.
If you have selected the Block foundation type in module window 1.1, the boxes for the bucket
wall thicknesses at the top and bottom are locked. If the Foundation plate has been set, all boxes
are deactivated.
If the bucket has been rated iteratively by the program (see below), you can import the determined dimensions with the [Import] button. Then, you can adjust the values, for example in
order to use rounded dimensions.

Rate
FOUNDATION Pro determines the dimensions of the bucket according to the requirements
resulting from the column and plate geometry (see Figure 2.18).
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2.2.4 Horizontal Link Layout in Bucket

Figure 2.20: Window section Horizontal Link Layout in Bucket

In this window section, you decide if the links in the bucket walls enclose the column or are
entirely located in the bucket wall.
The options are locked for the foundation types Block foundation and Foundation plate.

2.2.5 User Database of Foundation Templates

Figure 2.21: Window section User Database of Foundation Templates

You can store the current foundation geometry in a library by using the [Save] button. A dialog
box opens where you enter a name for the new template.

Figure 2.22: Dialog box Enter Name for New Template

Click [OK] to import the foundation to the Database of Foundation Templates.

Figure 2.23: Dialog box User Database of Foundation Templates
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2.3

Materials

Figure 2.24: Window 1.3 Materials

In this module window, you define the materials with the partial safety factors as well as the
settings for the reinforcement.

Concrete
The window section offers two lists where you can select the concrete Grade and the Reinforcement grade. The standardization of the material is based on the National Annex that has
been set in module window 1.1 General Data.
It is also possible to define the concrete and reinforcing steel grades with the [Library] buttons.
The dialog box Material Library additionally displays the properties of the materials. Again, it is
the National Annex that sets the materials available for selection.

Concrete Covers
Here, you define the concrete cover for the different sides of the foundation. The meaning of
the symbols is made clear by the sketches in the graphic on the right in the module window.
It is also possible to determine the concrete cover by the specifications in the standard. Then,
the check box for Minimum cover acc. to Standard must be selected. Click the [Edit] button to
access a dialog box where the concrete covers cbottom, ctop, cside/cbucket can be determined from parameters (see following figure).

20
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Figure 2.25: Dialog box Concrete Cover acc. to Standard

Partial and Reduction Factors
This window section allows for adjusting both the partial safety factors for concrete and reinforcing steel and the reduction factors needed to consider long-term effects. The values are
preset according to the selected standard. There are minor differences in the descriptions of
the design situations displayed in the column headings.
If the standard EN 1992-1-1 + EN 1997-1 has been selected without any country-specific
National Annex, the basic design situation is described by PT (persistent and transient)
and the accidental design situation by AC. This applies also to some national annexes.
When the German National Annex has been set, the description for the permanent design situation is BS-P / BS-T. For the accidental design situation it is BS-A.
The long-term load factors αcc and αct for compression and tension are preset with 0.85, the factor αct for bond is preset with 1.00.
Any changes made can be reset by clicking the [Preset Default Values for Eurocode] button.
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Reinforcing Steel Mats / Reinforcing Bars / Mandrel Diameter
In the window section Available Reinforcing Steel Mats, you can set a product range in the list.
The current range Germany - 2008-01-01 is set as default.

Figure 2.26: Selection of standard reinforcing steel mats and reinforcing bars

For the design of the foundation it is possible to select particular meshes from the product
range.
In case the selected mats area is not sufficient for the design of the foundation plate, supplementary reinforcement in the form of rebars must be inserted. The possible bar diameters can
be specified in the window section Reinforcing Bars.
Use the [Edit] button to reduce or extend the list of available rebar diameters.

Figure 2.27: Dialog box Edit List of Available Diameters

Irrespective of the foundation type defined in module window 1.1, you have to specify
at least one rebar section for the design of the foundation.
If the required cross-sectional area of the reinforcement is larger than it is possible to reach by
using the selected diameters, the program shows the following error message:

Figure 2.28: Error message for insufficient steel cross-sectional area

The current mesh and rebar configuration can be saved as default setting used for other
design cases by clicking the [Set as Default] button below the window sections. With the
[Default] button to the right you can preset the mats and bars in this module window.
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2.4

Loading

Module window 1.4 Loading consists of several tabs.

Figure 2.29: Window 1.4 Loading, tab Structural (STR) and Geotechnical (GEO)

Existing Load Cases / Combinations
This window section contains all load cases, load combinations, result combinations, and super combinations that have been created in RSTAB.
To transfer selected entries to the window section Selected for Design, click []. Alternatively,
you can double-click the entries. The button [] transfers the complete list to the right.
Multiple selection of load cases is possible with the common Windows function where you
hold down the [Ctrl] key. In this way, you can transfer several load cases at once.
Load cases without load data as well as imperfection load cases are marked red. They cannot
be designed. When you transfer such a load case, a corresponding warning appears.
Depending on the settings in the Details dialog box (see Figure 3.1, page 28), the tabs are
shown or hidden. For example, the tab Uplift (UPL) is omitted if the design according to EN
1997-1, 2.4.7.4 is not activated.
The load cases must be selected separately for each design situation.
This means that in each of the activated tabs for
•

Structural (STR) and Geotechnical (GEO)

•

Uplift (UPL)

•

Static Equilibrium (EQU)

•

Characteristic Values

at least one load case or combination must be selected for the design.
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Below the load case list, you find different filter options which make the selection of the design-relevant load cases and combinations easier. For example, you can use the filter to display
only the result combinations. The value in brackets indicates how many entries are available
for the respective filter setting.

Figure 2.30: Filter for selection of load cases and combinations

The buttons have the following functions:
Selects all cases in the list
Inverts selection of load cases
Table 2.2: Buttons in window section Existing Load Cases / Combinations

Selected for Design
The window section to the right lists the load cases, load combinations, result combinations,
and super combinations that are selected for the design. To remove selected entries from the
list, click [], or double-click the entries. To transfer the entire list to the left, click [].
In addition, you have to specify the design situation that is applied to the load cases and combinations to be designed. Click in the text box to enable the assignment.

Figure 2.31: Assigning the design situation

For the analyses of the structural system (STR) and the soil (GEO), the uplift (UPL), and the equilibrium limit state (EQU) you can choose between the basic combination Persistent and Transient PT and Accidental AC. Both options are provided in the list for most national annexes.
For the National Annex of Germany, however, the list shows the following entries:
•

Permanent

BS-P

•

Accidental

BS-A

•

Transient

BS-T

In the window tab Characteristic Values, you can assign a design situation also for the German
National Annex: The load constellation selected for the design of a 'twisted foundation' can
contain only permanent loads or support forces from permanent and variable loads. Of course,
in this case the design of the Highly eccentric loading in the core according to EN 1997-1, A 6.6.5
must be activated in the Details dialog box.
According to EN 1997-1 A 6.6.5, the verification of the first core range considers actions from
permanent loads. For the verification of the second core range, actions from permanent and
variable loads are used.
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Additional Loading
In the lower part of the module window, you can activate more loads for the design. The symbolic graphic to the right shows how the additional loads act on the foundation.

Figure 2.32: Window section Additional Loading

Loading
Selecting the check box opens the Loading dialog box for entering parameters.

Figure 2.33: Dialog box Loading

The loading is uniformly applied as a surface load to the entire foundation area from which the
cross-sectional area of the column is subtracted. In the Duration column, you decide if this additional surface load acts Permanent or Variable.
A Comment describing the additional load appears also in the printout report.
Line loads
Selecting the check box opens the Line Loads dialog box for entering parameters.

Figure 2.34: Dialog box Line Loads
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The Load Position of the line load can be described by the coordinates of its start and end
points. The entered values refer to the coordinate system of the support.
The line load can be defined only as a constant load. In the Duration column, you decide if the
load acts Permanent or Variable.
Concentrated loads
Selecting the check box opens the dialog box Concentrated Loads for entering parameters.

Figure 2.35: Dialog box Concentrated Loads

The Load Position is relative to the coordinate system of the support. In the table columns PX, PY
and PZ, you can enter the loading components available in X-, Y- and Z-direction.
In the Duration column, you decide if the load acts as Permanent or Variable.
Subsoil water level
You can also take into account the impact of the groundwater. The value a describes the depth
of the water table measured from the top edge of the earth covering to the water level.
In the Type list, you decide if the groundwater acts Permanent or Variable.
Earth covering
The loading due to the earth covering is generally applied as a permanent load.
If the check box is selected, you can specify the height c of the earth covering as well as the
specific weight γ of the soil. The dimension measured from the top edge of the foundation
plate applies to the value c. The specific weight is preset with 20 kN/m3.
If you have defined that the height of the earth covering will be increased in order to fulfill the
geotechnical designs in the dialog box Design Parameters for Foundation Plate (see Figure 2.18),
the earth covering cannot be deactivated in Window 1.4.
If the layout of the foundation plate dimensions leads to the result that the entered earth
covering is not sufficient for a frost-free embedment depth, the height of the earth covering will be automatically increased according to the settings in the Design Parameters dialog box (see Figure 2.18).
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The automatically increased value of the earth covering is not visible in module window 1.4.
Instead, the actual applied covering height c is displayed in the results window 2.1 Geometry.

Figure 2.36: Note about automatically increased earth covering after calculation
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3.

Calculation

3.1

Detail Settings

Before you start the calculation, it is recommended to check the design details. To open the
corresponding dialog box, use the [Details] button available in every window of the add-on
module.

Figure 3.1: Dialog box Details

3.1.1

Foundation Plate

You can set a Minimum reinforcement according to 9.2.1.1 for the foundation plate. In this case,
the required minimum area of the longitudinal tension reinforcement is taken into account
according to [1] 9.2.1.1 for the design.
The option Without bending reinforcement according to 12.9.3 is currently in preparation. This
setting will allow you to design the foundation according to [1] 12.9.3 as a single foundation
without reinforcement.
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3.1.2

Location of the Design Section

In this window section, you define the location of the section for which the bending design of
the foundation plate is performed. This specification applies to the top and the bottom reinforcement layer of the foundation plate.
The position of the design section for the reinforcement's bottom and top layer can also be
Defined individually: Selecting the option opens a dialog box where the position of the design
section can be described by the distances Delta-x and Delta-y (see following figure).

Figure 3.2: Dialog box Define Location of Design Section in Foundation Plate

3.1.3

Geotechnical Design Acc. to EN 1997-1

The check boxes in this dialog section determine the geotechnical designs included in the
verification.
At least one geotechnical design must be selected for the verification!
The settings also affect the load cases that must be selected for the design in module window
1.4. For example, the window tab Uplift (UPL) is omitted in Window 1.4 if the uplift limit state
design according to [2] 2.4.7.4 is deactivated.

Equilibrium limit state (EQU)
In accordance with [2] 2.4.7.2, the design for the limit state of the static equilibrium or the
overall displacement of the structural system or the ground is the following:

E dst , d ≤ E stb, d + Td
Formula 3.1

FOUNDATION Pro performs this design as follows:

Mdst ,i ≤ Mstb ,i
Formula 3.2

The moment M represents the destabilizing or stabilizing moment resulting on an edge i.
The actions created by the moments must be reduced (stabilizing) or increased (destabilizing)
with the corresponding partial safety factor γF from [2] A.2.
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Uplift limit state (UPL)
According to [2] clause 2.4.7.4, the verification for the uplift must be performed in such a way
that the design value of the combination of destabilizing permanent and variable vertical actions Vdst,d is less than or equal to the sum of the design value of the stabilizing permanent vertical actions Gstb,d and of the design value of any additional resistance Rd to uplift.

Vdst ,d ≤ Gstb,d + R d
where

Vdst ,d = Gdst ,k ⋅ γ G,dst + Q dst ,k ⋅ γ Q ,dst

Gstb,d = Gstb,k ⋅ γ G,stb
Formula 3.3

The additional resistance Rd as a result of any acting stabilizing shear force can but does not
need to be considered for this design. This resistance is not taken into account in FOUNDATION
Pro.
The partial safety factors γ must be taken from [2] A.4.

Ground failure
The design for the ground failure belongs to the limit state STR/GEO-2 according to [2]. The actions acting perpendicular to the foundation's base level are compared with the design values
of the resistances.

V'd ≤ R d
Formula 3.4

An analytical method according to [2] 6.5.2(2) is applied. In [2] annex D, you find an informative
example for determining the ground failure resistance analytically.
The actions and resistances must be reduced with the partial safety factors γ according to [2]
A.3.
Effective area in case of off-center loading
The ground failure analysis considers only a part of the actually existing base area, which is the
part where the resulting axial force acts on the center.
The effective area A' is calculated at the beginning of the verification.
A' = B' ⋅ L'

where

B' ≤ L'

B' = B − 2e b

eb is the effective load eccentricity that belongs to side B

L' = L − 2e l

el is the effective load eccentricity that belongs to side L

Sliding
According to [2] clause 6.5.3, a failure due to sliding in the base area must be analyzed if the
load vector is not normal to this area.
A risk for sliding exists if the design value of the force Hd resulting parallel to this area in the direction of the displacement is larger than the sum of the design values of the resistance
against sliding Rs,d and the earth resistance Rp,d.
Therefore, it must be verified that the following condition is met:

Hd ≤ R s , d + Rp , d
Formula 3.5
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The resistances must be reduced with the partial safety factors γ according to [2] A3.3.1.
Resistance against sliding for drained conditions

Rs,d =

R s ,k
γ R ,h

R s ,k = V'd ⋅ tan(δs , d )
For the design value of the angle of soil friction according to [2] 6.5.3 (10) the standard allows
for cast-in-situ concrete foundations to apply the design value of the critical angle of shearing
resistance φd. This angle must be reduced with the partial safety factor γ according to [2] A.3.2.

δ s , d = ϕd =

ϕ'k
γ ϕ'

According to [2] /NA:2010-12, the following must be fulfilled: δs,k ≤ 35°.
Resistance against sliding for undrained conditions

Rs,d =

R s ,k
γ R ,h

R s ,k = A'⋅

cuk
γ cu

Earth resistance

R p ,d =

R p ,k
γ R ,v

(

)

(

)

R p ,x ,k = 0.5 σp ,t + σp ,b ⋅ d ⋅ x
R p ,y ,k = 0.5 σp ,t + σp ,b ⋅ d ⋅ y

(

σp ,o = c'd ⋅K pch + K agh ⋅ p d,perm + p d,var + γ c ,d ⋅ c

(

)

up ,u = c'd ⋅K pch + K pgh ⋅ γ1,d ⋅ d + p d,perm + p d,var + γ c ,d ⋅ c

)

p d,perm = pk ,perm ⋅ γ Q
p d,var = pk ,var ⋅ γ G
If α = β = δ = 0, the passive earth pressure due to cohesion can be assumed as follows:

K pch = 2 ⋅ K pgh
For [2] /NA:2010-12, δ should be zero according to 6.5.3 (16). Therefore, the formula above is
always used for the design according to the German National Annex.
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Loads with large eccentricities
In accordance with [2] 6.5.4, no special arrangements must be taken if the following applies in
general to a rectangular base area:

1
e x ≤ e all = ⋅ b x
3
Formula 3.6

1
e y ≤ e all = ⋅ b y
3
Formula 3.7

Highly eccentric loading in the core (only for DIN EN 1997-1)
When the German National Annex has been set, the description for the permanent
design situation is BS-P / BS-T. For the accidental design situation it is BS-A.
The verification according to [2] A 6.6.5 checks if a gaping of joints due to permanent actions
and unfavorable load combinations occurs beyond the centroid of the base area.

Permanent actions
The resultant from all characteristic loading Vk acting on the foundation base should be within
the first core area. Only actions but no resistances are considered.

Unfavorable combination from permanent and variable actions
The resultant from all characteristic loading Vk should not be outside the second core area.
Again, only actions are considered.
Verification showing that Vk is inside the first core area:

ex ey 1
+
≤
bx by 6
Formula 3.8

Verification showing that Vk is not outside the second core area:

e
 x
b
 x

2
  e y
 +
 b
  y

2


 ≤1

9


Formula 3.9

3.1.4

Concrete Design Acc. to EN 1992-1-1

This dialog section allows you to deactivate Punching for the steel design. Then, the options in
the Punching dialog section to the right are disabled.
Checking the Lap length of bucket reinforcement according to [1] 8.7.3 is only available for
bucket and block foundations with rough bucket or wall sides.
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3.1.5

Punching

This dialog section manages the parameters that are relevant for the punching shear designs.

Figure 3.3: Dialog section Punching

The control perimeter can be determined by an Iterated calculation or specified by a manual
Definition of the distance lw.
The check box for The defined punching cone in the distance lw and the lw,def text box are accessible even if the punching has been deactivated in the Concrete Design dialog section. The check
mark controls the position of the punching cone relative to the foundation plate. If the cone
does not lie within the plate, the plate's minimum dimensions will be adjusted with the punching cone during the layout process.
Click the [Info] button to open a graphic showing the foundation parameters.

Figure 3.4: Dialog box Information for rough bucket foundation
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Furthermore, the Punching dialog section offers the possibility to adjust the component of the
favorably acting soil stresses for the punching shear design by means of the Factor for the consideration of the unloaded soil stress inside the control perimeter.
According to [1] 6.4.4, it is allowed to apply the sum of ground pressures within the punching
cone as a relief of up to 100 % if the control perimeter for the punching shear design of the
foundation plate was determined iteratively. If the constant perimeter is assumed in a distance
of 1.0 d in order to simplify the calculation, it is allowed to assume only 50 % of the sum of soil
pressures within the constant perimeter as a relief.

Figure 3.5: Factor kred depending on defined distance

With the list at the end of the dialog section you can find out the Parameter β by using different possibilities. The load increment factor can be determined under the assumption of a fully
plastic shear stress distribution according to [1] 6.4.3 (3) or on the basis of constant factors according to [1] 6.4.3 (6). In addition, it is possible to enter a user-defined value into the β box.

3.1.6

Loads in Window 1.4

Use the check box Equal for all foundations to define that the loading of the first foundation is
applied also to all further, newly added foundations. This option is not active by default so that
each foundation is designed with its own loads.
If you deactivate the default option Apply the same loads for (STR) and (GEO), you can enter the
load cases separately for the reinforced concrete design and the geotechnical designs in module window 1.4 Loading.

Figure 3.6: Window 1.4 Loading with separate input for Structural (STR) and Geotechnical (GEO)

Moreover, this dialog section allows you to Include effects from second order theory acc. to 5.1.4
by increasing the support moment. This may apply for example to the foundation of a reinforced
concrete bracket that was designed by using the model column method according to linear
static analysis.
If the check boxes are selected, you can specify factors for the y- and x-axis to increase the fixing moment. In this way, it is possible to consider the influence from second-order analysis.

34

Program FOUNDATION Pro © 2014 Dlubal Software GmbH

3 Calculation

3.1.7 Deactivation of Support Loads for Foundation Design
With the check boxes in this dialog section you can prevent particular support reactions for
the design. Separate settings are possible for the support loads Px, Py and Pz and the support
moments Mx and My. The specifications apply to the current design case only.

Figure 3.7: Dialog section Deactivation of Support Load for Foundation Design

When a Support load type is selected, you can open the corresponding list and select the forces
or moments that you want to ignore (in positive or negative direction, or all).
If components of support reactions are suppressed for the design, it is documented in the
results windows available after the calculation.

3.2

Minimum Dimensions

Bucket foundation with smooth bucket sides
Minimum dimensions
Minimum side lengths from column dimensions:

x = c x + 2 ⋅ (t tx + a tx ) + 2⋅ | e x |

(

)

y = c y + 2 ⋅ t ty + a ty + 2⋅ | e y |
Minimum side lengths for control perimeter within foundation plate:

 c x + 2 ⋅ (lsw ) + 2⋅ | e x | 
x = max 

c x + 2 ⋅ (t tx + a tx ) + 2⋅ | e x |
 c y + 2 ⋅ (lsw ) + 2⋅ | e y | 
y = max 

c y + 2 ⋅ t ty + a ty + 2⋅ | e y |

(

where lsw

)

Distance between punching cone and column edge

Minimum embedment depth of column
Minimum embedment depth min t according to [1] 10.9.6.3:
min t = 1.2 ⋅ c

Minimum embedment depth recommended according to [1] /NA:2011-01:
min t1 = 1.5 ⋅ c
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Bucket foundation with rough bucket sides
Minimum dimensions
Minimum side lengths from column dimensions:

x = c x + 2 ⋅ (t tx + a tx ) + 2⋅ | e x |

(

)

y = c y + 2 ⋅ t ty + a ty + 2⋅ | e y |
Minimum side lengths for control perimeter within foundation plate:

x = c x + 2 ⋅ (t tx + a tx ) + 2 ⋅ (lsw ) + 2⋅ | e x |

(

)

y = c y + 2 ⋅ t ty + a ty + 2 ⋅ (lsw ) + 2⋅ | e y |
where lsw

Distance between punching cone and column edge

Minimum embedment depth of column
The minimum embedment depth is calculated according to [6] Chapter 16.3.3.1.

e=

M
Pz ⋅ c

Variable

Description

e

Related load eccentricity

M

Fixing moment of column on top side of bucket

Pz

Axial force of column

c

Column dimension

Table 3.1: Variables for calculation of minimum embedment depth

e ≤ 0.15 :

min t1 = 1.2 ⋅ c
0.15 < e < 2.00 :

2.0 − 1.2


⋅ (e − 0.15) ⋅ c
min t1 = 1.2 +
−
2
.
0
0
.
15


e ≥ 2.00 :

min t1 = 2.0 ⋅ c
If a value entered in module window 1.2 Geometry falls below the minimum value (see Figure
2.19, page 18), the program replaces the value automatically by the minimum value. When the
foundation plate thickness is increased, the minimum side lengths will be recalculated automatically.
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Foundation plate
The following conditions apply to the minimum dimensions, depending on the selected plate
thickness t and the specified position of the control perimeter (see Details dialog box):

t min = 20 cm
Minimum side lengths from column dimensions:

x = c x + 2⋅ | e x |
y = c y + 2⋅ | e y |
Minimum side lengths for control perimeter within foundation plate:

x = c x + 2 ⋅ lsw + 2⋅ | e x |

y = c y + 2 ⋅ lsw + 2⋅ | e y |

Variable

Description

cx

Column dimension in the x-direction

cy

Column dimension in the y-direction

x

Foundation plate dimension in the x-direction

y

Foundation plate dimension in the y-direction

t

Thickness of foundation plate

e

Eccentricity of column

lsw

Distance between punching cone and column edge

Table 3.2: Variables of foundation geometry

Block foundation with rough bucket sides
Minimum dimensions
The same minimum thicknesses tmin and minimum side lengths, which are valid for the foundation plate (see above), apply to the block foundation.

t min = 20 cm
Minimum side lengths from column dimensions:

x = c x + 2 ⋅ a tx + 2⋅ | e x | + 20 cm
y = c y + 2 ⋅ a ty + 2⋅ | e y | + 20 cm

Minimum embedment depth of column
Minimum embedment depth according to [4] 2.6.4:

t = 1.5 ⋅ c
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Block foundation with smooth bucket sides
Minimum dimensions
Minimum plate thickness:

(

t min = h + max 15 cm ; 10 cm + c nom,top + c nom,bottom

)

Minimum side lengths from column dimensions:

x = c x + 2 ⋅ a tx + 2⋅ | e x | + 50 cm
y = c y + 2 ⋅ a ty + 2⋅ | e y | + 50 cm
The foundation plate is increased about 50 cm (25 cm on each side of the column) in order to
provide enough space for the vertical links Lvx and Lvy.
Minimum side lengths for control perimeter within the foundation plate:

x = c x + 2 ⋅ lsw + 2⋅ | e x |
y = c y + 2 ⋅ lsw + 2⋅ | e y |
Variable

Description

h

Thickness of foundation plate

cnom

Concrete cover

c x / cy

Column dimension in the x- and y-direction

at / ab

Column allowance top and bottom

ex / ey

Eccentricity in the x- and y-direction

lsw

Distance between punching cone and column edge

Table 3.3: Variables for determination of minimum dimensions

Minimum embedment depth of column
Like the bucket foundation with smooth bucket sides (see above), the minimum embedment
depth min t is the following according to [1] 10.9.6.3:

(

min t = 1,2 ⋅ max c x ; c y

)

Minimum embedment depth recommended according to [1] /NA:2011-01:

(

min t1 = 1,5 ⋅ max c x ; c y

)

The minimum value is taken into account accordingly for the design performed with the
National Annex of Germany.
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3.3

Start Calculation

To start the calculation, click the [Calculation] button that is available in all input windows of
the add-on module.
FOUNDATION Pro searches for the results of the load cases, load and result combinations to
be designed. If they cannot be found, the RSTAB calculation starts to determine the designrelevant internal forces.
You can start the calculation also in the RSTAB user interface: Use the dialog box To Calculate
(menu Calculate → To Calculate) where the design cases of the add-on modules as well as
the load cases or load combinations are listed.

Figure 3.8: Dialog box To Calculate in RSTAB

If the design cases from FOUNDATION Pro are missing in the Not Calculated list, select All or
Add-on Modules in the drop-down list below.
To transfer the selected FOUNDATION Pro cases to the list on the right, use the button [].
Then, click [OK] to start the calculation.
Alternatively, you can start the calculation of a design case by using the drop-down list in the
toolbar: Select the FOUNDATION Pro case, and then click [Show Results].

Figure 3.9: Direct calculation of a FOUNDATION Pro design case in RSTAB
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Subsequently, you can observe the calculation process in a separate dialog box.

Figure 3.10: FOUNDATION Pro calculation
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4.

Results

Module window 2.1 Geometry is displayed immediately after the calculation.
The navigator on the left shows the other results windows where the governing designs as
well as the reinforcements are indicated. To select a window, click the corresponding navigator entry. To go to the previous or subsequent window, use the buttons shown on the left.
Alternatively, you can use the function keys to go the next [F2] or previous [F3] window.
Click [OK] to save the results. You exit FOUNDATION Pro and return to the main program.
Chapter 4 Results describes the different results windows one by one. Evaluating and checking
the results is described in Chapter 5 Results Evaluation on page 53.

4.1

Geometry

Module window 2.1 shows all dimensions resulting from the design process for the foundation
plate and, if applicable, the bucket.

Figure 4.1: Window 2.1 Geometry

As common in Windows applications, the list entries can be expanded with [+] and collapsed
with [-]. The amount of the output data depends on the foundation type: For example, there
are no bucket dimensions for a designed foundation plate.
The foundation is graphically represented on the right in the module window. In this graphical
window, you can use the mouse functions that you already know from RSTAB: It is possible to
zoom, shift or rotate the view. The corresponding buttons are described in Chapter 5.1 on
page 53.
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4.2

Governing Design Criteria

The upper part of the window offers a summary of the governing designs sorted by design
criteria.
The lower part contains detailed data for the design that is selected in the upper part.

Figure 4.2: Window 2.2 Governing Design Criteria

Design Type
This table column shows the description of the performed design.

Governing Node / LC
The two columns show information about the support node on which the governing support
force is available and the load case, load combination or result combination where the force
occurs.

Design Criterion
When the Rate option has been set, the dimensions are always chosen in a way that the design
criterion is ≤ 1.00, and thus the respective design is fulfilled. When the option Define dimensions
has been set, the designs that are not fulfilled with the entered dimensions are described with
values that are > 1.00.
In case a design is not required, it is indicated by 0.000.

Comment to Design Type
The final table column can contain important notes describing the design. These notes are
summarized in a dialog box that you can access by clicking the [Messages] button.
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Result filter
Below the table, you see a row with a check box and several lists.

Figure 4.3: Result filter for table

If the check box Node No. is selected, you can use the list and select a node whose results you
want to be displayed in the table. The LC / CO list can additionally be used to filter the results
by load cases. This function has also been described in the DLUBAL blog:
www.dlubal.com/blog/12558

Details
As an example for the structure of a details table, find a presentation of the designs for the
concrete stresses in the bucket walls below.
The shortcut menu of the details table can be used to open or close the entire results tree:
Right-click anywhere in the details table to access the options shown on the left.

Figure 4.4: Details for concrete stress design in bucket walls

The output is subdivided into two sections for the x- and y-directions. First, the governing internal forces are listed, the required intermediate results follow. At the end, you see the design
criterion that is displayed for each direction.

Program FOUNDATION Pro © 2014 Dlubal Software GmbH

43

4 Results

Graphic
The graphical window in this module window shows an interactive graphic of the foundation.
The picture is aligned with the table row selected in the details table to the left.

Figure 4.5: Graphic of compression stresses

For example, the figure above demonstrates how the compression stresses are distributed
under the foundation plate. These stresses are contained in the details of the punching shear
design.
The view functions and buttons are described in Chapter 5.1 on page 53.

4.3

Required Reinforcement

Also this module window consists of two tables and a graphical window.

Figure 4.6: Window 2.3 Required Reinforcement
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Type of Reinforcement
This table column lists the parts of the foundation for which the reinforcement is provided
(foundation plate, horizontal and vertical bucket links, reinforcement in bucket wall). In addition, it is indicated in which direction and position the reinforcement must be arranged.

Pos
Each reinforcement receives a position name under which it can be found later in the reinforcement drawing (see Chapter 5.3, page 57).

Reinforcement Description
Here, the reinforcement's short descriptions are indicated as symbols.

Reinforcement Area
This column shows the required areas of reinforcement steel.

Unit
If necessary, the units of the reinforcement areas can be adjusted as described on page 64.

Details
The lower part of the module window lists the design details of the reinforcement type that is
selected in the table above.

Figure 4.7: Details table for reinforcement of foundation plate, bottom, in x, area I

Graphic
The graphical window in this module window shows an interactive graphic of the foundation.
The picture is aligned with the table row selected in the details table to the left.
Click the [3D-Rendering] button to visualize the reinforcement in a separate graphical window.
This function is described in Chapter 5.2 on page 54.
Use the [Drawings] button to look at the reinforcement drawings of the foundation (see Chapter 5.3, page 57).
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4.4

Plate Reinforcement - Bottom

In this module window, the reinforcement for the bottom side of the foundation plate is
shown. The plate reinforcement is suggested by the program but can be changed, here.

Figure 4.8: Window 2.4 Plate Reinforcement - Bottom

Basic Reinforcement
In the upper part of the module window, the suggested basic reinforcement is indicated with
a position number. The Mat can be changed by using the list. The list contains all mat types activated for the design in module window 1.3 (see Figure 2.26, page 22).

Reinforcement in Direction x / Reinforcement in Direction y
In both window sections, it is possible to adjust the bar reinforcement suggested by FOUNDATION Pro.

Figure 4.9: Adjusting the reinforcement (here: main reinforcement in direction x)

Areas of reinforcement
With the list you can define if the bar reinforcement is divided in one or three Areas of reinforcement.
If one reinforcement area is set, the bending reinforcement required from the design is applied
to the entire plate width. If three reinforcement areas are possible, the plate width is subdivided into three areas. Then, the required reinforcement is inserted by curtailment, which proves
to be more efficient in most cases.
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In the first table column, the Pos. position name of the reinforcement is displayed.
The Area column describes the area of the plate reinforcement. In case you have set three areas of reinforcement, you get two external reinforcement areas (indicated by yl in Figure 4.9)
and one reinforcement area in the plate center (indicated by yll in Figure 4.9).
The Length column shows the dimensions of the individual areas of reinforcement that are
available in the direction. These lengths are also displayed in the graphical reinforcement layout for the main and secondary reinforcement direction (see Figure 4.10).
In the table columns Rebars, Prov asx and Req asx, the selected reinforcement is shown. In addition to the rebar diameters and spacing, you see the reinforcement area of the provided and
the required reinforcement.

Figure 4.10: Graphic of reinforcement layout

FOUNDATION Pro determines the main and secondary reinforcement direction according to
the actions applied to the foundation. If the main reinforcement is oriented in the x-direction,
the reinforcement in the x-direction lies in the lowest layer.

Different Reinforcement Proposal
Use the button [Different Reinforcement Proposal] to select an alternative reinforcement for
the plate. The dialog box Select Different Reinforcement Proposal opens (see following figure).
In this dialog box, you can define another mat as the basic reinforcement (any mat set according to module window 1.2 Material is possible). Furthermore, please note that the mat for the
basic reinforcement can only be specified for the main reinforcement direction. The other dialog box used to change the secondary reinforcement direction presets the mat of the main reinforcement direction. There, the mat list is not accessible, as shown in Figure 4.11.
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Figure 4.11: Dialog box Select Different Reinforcement Proposal (here: secondary reinforcement)

In the tables, you can choose an alternative reinforcement for each Area. The combinations of
basic mats and rebars are predefined. Rebar diameters or spacing cannot be changed, here.
The combinations of the reinforcements are sorted in ascending order by the available areas of
reinforcement Prov as. You can select the relevant proposal by clicking in the list of all possible
reinforcement combinations. Then, click [OK] to transfer the new reinforcement to module
window 2.4.
If the reinforcement for the main or secondary direction has been changed, the results must be
recalculated. Use the [Calculation] button which is enabled after any modification of the reinforcement.
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4.5

Plate Reinforcement - Top

Figure 4.12: Window 2.5 Plate Reinforcement - Top

The structure of Window 2.5 with its input options is the same like in Window 2.4 Plate Reinforcement - Bottom (see Chapter 4.4). Again, it is possible to select a reinforcement combination from a list as an alternative to the designed reinforcement.
The only difference to Window 2.4 is that the curtailment of reinforcements is not possible: The
same design moment is applied to all eight design areas.
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4.6

Bucket Reinforcement

This module window shows the reinforcement of the bucket. It is possible to change the bucket reinforcement suggested by the program.
The window is not available when the foundation type Foundation plate has been set.

Figure 4.13: Window 2.6 Bucket Reinforcement

The upper table displays the individual positions of the bucket reinforcement including reinforcement areas as well as diameter, number and spacing of rebars.
The graphic shows a rendered representation of the bucket reinforcement. When you click on
a position listed in the table, you can see that it is marked in gray in the graphic. Again, you can
use the mouse functions that you already know from RSTAB in order to zoom, shift or rotate
the view. The corresponding buttons are described in Chapter 5.1 on page 53.
The determined bucket reinforcement can be modified in the table columns that have a white
background. The values in the gray columns are set by the program and cannot be changed.
The following changes can be carried out for the reinforcement:
•

Diameter of reinforcement

•

Selected quantity of reinforcement

•

Spacing of reinforcement

The bar diameter d can be changed by using the list. For the selection it is important to bear
in mind that the reinforcement with its bar and mandrel diameters must still fit in the bucket
walls.
The table columns Selected Quantity of Reinforcement and Spacing are interdependent. Use
those columns to adjust the number of rebars or the bar spacing (considering the possible layout width). If the spacing is changed, the number of possible rebars is adjusted automatically.
For example, if the spacing is reduced, the number of bars that can be placed in the given Layout Width is displayed in the table column Possible. Then, using this target specification, the
desired number of rebars can be entered.
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If it is the opposite case where the number of selected reinforcing bars is changed, the program adjusts the spacing between the rebars automatically.
In case of modifications, it is necessary to recalculate the bucket reinforcement. Use the
[Calculation] button for the recalculation.
If the changed entry results in errors during the layout of the reinforcement, the problem causing position is highlighted with red in the table. A note appears in the window section Message, which is useful for a new adjustment of the reinforcement.

4.7

Steel Schedule

Figure 4.14: Window 2.7 Steel Schedule

No changes are possible in this results window.
The steel schedule offers information about the mats (mesh reinforcement). Moreover, detailed data is displayed for additional rebars and the bucket reinforcement of each position:
•

Number of rebars per foundation

•

Total rebar number of all foundations

•

Section length of a link

•

Total length of all links

In addition, the Total Length of all reinforcing bars that have the same diameter as well as the
Total Weight of the bars and mats are shown.
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4.8

Concrete Cubage

Figure 4.15: Window 2.8 Concrete Cubage

The results window provides information on how many cubic meters of concrete are needed
for the Foundation Plate, the Bucket and the Backfill Concrete between the bucket and the column of one or all foundations.
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5.

Results Evaluation

After the design, you have several possibilities to evaluate the results and to prepare them for
the documentation.

5.1

Graphic of Foundation in Results Window

In most results windows, dynamic graphics are displayed showing the foundation or reinforcement. They illustrate the parameters and help you to keep a clear overview.

Figure 5.1: Interactive graphic in Window 2.2 for safety against bending failure

The buttons below the graphic have the following functions:
Button

Description

Function

Dimensions

Turns on/off dimension lines

Isometric view

Shows object in isometric view

Perspective view

Turns on/off perspective view

Show all graphic

Resets full view of foundation

View in X

Shows view in direction of X-axis

View in -Y

Shows view in opposite direction of Y-axis

View in Z

Shows view in direction of Z-axis

Values

Shows and hides load and result values

Print

Allows for printing current foundation graphic

Table 5.1: Graphic buttons in results windows

Use the mouse to zoom, shift or rotate the view. The functions are described in Chapter 3.4.9 of
the RSTAB manual (see also the following Chapter 5.2).
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5.2

3D-Rendering

The [3D-Rendering] button is available in all results windows, offering the possibility to access
a photo-realistic representation of the foundation.

Figure 5.2: Graphical window with 3D rendering of a bucket foundation reinforcement

Menu bar
The File menu provides functions for printing the graphic (see Chapter 6.2).
With the functions of the Options menu, you can adjust the graphical representation:

Grab (Move, Rotate, Zoom)
The symbol of the mouse pointer turns into a hand. Thus, it is possible to shift, rotate or zoom
the graphic display of the foundation.
To shift the foundation, click with the hand symbol in the graphical window, keep the mouse
button pressed and move the pointer in the corresponding direction.
To rotate the foundation, click in the graphical window while keeping the [Ctrl] key pressed
and move the pointer in the corresponding rotational direction.
To zoom the foundation, move the mouse up or down while keeping the [Shift] key pressed.
It is also possible to adjust the view directly with the mouse (see Chapter 3.4.9 of the RSTAB
manual).

Zoom
The symbol of the mouse pointer turns into a magnifying glass. Now, if you draw a window
across a particular zone of the graphic, it is enlarged in a partial view.
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Reinforcement to Display
Clicking this menu item opens the dialog box Reinforcement to Display.

Figure 5.3: Dialog box Reinforcement to Display

By selecting the check boxes you can decide which of the reinforcement types are displayed in
the foundation's 3D rendering mode. Depending on the foundation type, some entries are not
selectable.
If you switch from the option Location of reinforcement to the option Forces and loads in the
dialog section Categorize Reinforcement According To, the dialog section in the bottom right
becomes accessible. There, it is possible to select the reinforcement resulting from particular
loads.

White Background
Select this menu item to change the black graphical background, which is default, to a white
one. The setting remains active for the current design case.
The white background can be permanently set by using the Configuration Manager of RSTAB
(see Chapter 3.4.10 of RSTAB manual).
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Toolbar
The toolbar offers different possibilities for printing and adjusting the graphical representation.

Figure 5.4: Toolbar buttons

In addition to the buttons described in Table 5.1, the following functions are available:
Button

Description

Function

Previous view

Shows the last selected view

Axes

Shows and hides the axis symbols

Member

Shows and hides the connected member

Dimensions

Turns on/off the dimension lines

Loads

Shows and hides the loads

Table 5.2: Buttons in Graphical window

With these functions, it is not only possible to check the reinforcement but also the applied
loading.

Figure 5.5: Foundation graphic with loads and dimensions
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5.3

Reinforcement Drawings

The [Drawings] button is available in all results windows, offering the possibility to access a reinforcement drawing for the foundation.

Figure 5.6: Reinforcement drawing of a bucket foundation

Menu bar
The File menu provides functions for printing the graphic (see Chapter 6.2).
You can enlarge the graphical representation with the zoom function in the Options menu
(see description in the previous chapter 5.2).
The functions in the Dimension menu help you control the dimensioning of the bars in the excerpt on the left (position 15 in the previous figure) for the rebar fabrication:
•

Tangential:

Lengths relative to outside edges of reinforcement

•

Axial:

Lengths relative to centroid of reinforcement (center lines)

•

Center of mandrel:

Lengths relative to center point of mandrel
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Toolbar
The toolbar offers different possibilities for printing and modifying the section that runs
through the foundation.

Figure 5.7: Toolbar buttons

Depending on the foundation type, up to seven different sections are available for selection:
Button

Description

Function

Section A-A

Top view of bottom plate reinforcement

Section B-B

Top view of top plate reinforcement

Section C-C

Top view of bucket

Section D-D

Section through bucket center, viewing direction in X

Section E-E

Section through bucket wall, viewing direction in X

Section F-F

Section through bucket center, viewing direction in Y

Section G-G

Section through bucket wall, viewing direction in Y

Table 5.3: Buttons in Reinforcement Drawing

If the structure does not require any reinforcement for the top layer, for example in case of
a plate foundation, the button for the section B-B is deactivated.
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5.4

Results on RSTAB Model

The graphic of the foundation can also be displayed on the RSTAB model: Click the [OK] button
to exit the add-on module FOUNDATION Pro. Then, go to the RSTAB menu bar, and select the
FOUNDATION Pro design case in the load case list.
Now, the foundation is visualized in a 3D rendering in the work window of RSTAB. If you cannot see it, you must turn on the results by using the [Show Results] button.

Figure 5.8: Graphical representation of a bucket foundation in RSTAB work window (display option: solid transparent)

If the Solid Transparent Display Model is set, the foundation is presented as shown in Figure 5.8.
Hidden edges and surfaces are visible.
The Solid Display Model shows the foundation – as the entire model – with filled surfaces. With
the Wireframe Display Model, RSTAB displays symbolically only the number of the foundation,
the foundation type and the dimensions of the foundation plate.

Figure 5.9: Bucket foundation represented with wireframe model
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6.

Printout

6.1

Printout Report

Like in RSTAB, the program generates a printout report for the FOUNDATION Pro results, to
which you can add graphics and descriptions. The selection in the printout report determines
which data of the design module will be included in the final printout.
Large and complex structural systems can be clearly documented if the data is split into several printout reports. In this way, it is possible to print for example the output of the add-on
module FOUNDATION Pro in a separate printout report.
The printout report is described in the RSTAB manual. In particular, Chapter 10.1.3.5 Selecting
Data of Add-on Modules describes how to prepare input and output data from add-on modules
for the printout. Various selection options are available for FOUNDATION Pro. You can define,
for example, how the designs are documented (Short form, Long form) and which reinforcement drawings are included in the report.

Figure 6.1: Selection of FOUNDATION Pro data in printout report
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Figure 6.2: Printout for FOUNDATION Pro with reinforcement drawings and designs

6.2

Graphic Printout

Both the graphics of the foundation or reinforcement of the add-on module FOUNDATION Pro
(see Figure 5.2, page 54) and the graphics of the RSTAB work window (see Figure 5.8, page 59)
can be prepared for the printout. Thus, it is possible to document the reinforcements as well as
the foundation objects displayed in the RSTAB model.
The print function can be accessed with the [Print Graphic] button which opens the following
dialog box.

Figure 6.3: Dialog box Graphic Printout

The dialog box Graphic Printout is described in Chapter 10.2 of the RSTAB manual.

Program FOUNDATION Pro © 2014 Dlubal Software GmbH

61

7 General Functions

7.

General Functions

This chapter describes useful menu functions as well as export options for the results of
FOUNDATION Pro.

7.1

Design Cases

Design cases allow you to group foundations for the designs, or to handle foundations in different design variants (for example different dimensions or materials).
In case several design cases are used, it is possible to analyze a node number several times.
But a node can be selected only once within the same design case (see also Chapter 2.1,
page 10).

Create a new design case
To create a new design case, use the FOUNDATION Pro menu and select
File → New Case.
The following dialog box appears:

Figure 7.1: Dialog box New FOUNDATION Pro Case

In this dialog box, enter a No. (one that is still available) for the new design case. An appropriate Description will make the selection in the load case list easier.
When you click [OK], module window 1.1 General Data opens where you can enter the new
design data.

Rename a design case
To change the description of a design case, use the FOUNDATION Pro menu and select
File → Rename Case.
The following dialog box appears:

Figure 7.2: Dialog box Rename FOUNDATION Pro Case

Here, you can specify a new Description as well as a different No. for the design case.
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Copy a design case
To copy the data entered for the current design case, use the FOUNDATION Pro menu and
select
File → Copy Case.
The following dialog box appears:

Figure 7.3: Dialog box Copy FOUNDATION Pro Case

Define the No. and, if necessary, a Description for the new case.

Delete a design case
To delete a design case, use the FOUNDATION Pro menu and select
File → Delete Case.
The following dialog box appears:

Figure 7.4: Dialog box Delete Cases

First, select the design case from the Available Cases list. To delete the case, click [OK].
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7.2

Units and Decimal Places

The units and decimal places for RSTAB and the add-on modules are managed in one common
dialog box. To access the dialog box for adjusting the units, use the FOUNDATION Pro menu
and click
Settings → Units and Decimal Places.
The program opens the following dialog box that you already know from RSTAB. FOUNDATION
Pro is preset in the list Program / Module.

Figure 7.5: Dialog box Units and Decimal Places

To reuse the settings in other models, save them as a user-profile. The corresponding functions
are described in the RSTAB manual, Chapter 11.1.3.
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7.3

National Annexes

Selection of national annex
As already described in Chapter 2.1 on page 11, the add-on module FOUNDATION Pro provides different national annexes for the design.
Find a list of the national annexes currently implemented in FOUNDATION Pro also on the web
product page: www.dlubal.com/en/foundation-pro-8xx.aspx

National annex in RSTAB and FOUNDATION Pro
In FOUNDATION Pro, it is possible to choose a different national annex than in the main program RSTAB where the annex is used for the creation of load and result combinations. Both the
standard and the National Annex are necessary for the partial safety factors and combination
coefficients of the superposition (see Manual for RSTAB, Chapter 12.2.1 about creating a model
and classifying load cases and combinations).
In case different national annexes are used, make sure that the design-relevant load and result
combinations have been created using the correct factors.

Consideration of consequences class
When the load or result combinations are created automatically, it is possible to define the
consequences class according to [3], annex B3. The selection of the consequences class, and
thus of the factor KFl, also has an influence on the results in FOUNDATION Pro.

Figure 7.6: RSTAB dialog box Coefficients for selection of consequences class CC

The consequences class, which is defined in this dialog box, is considered in the add-on module
FOUNDATION Pro, too.
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The factor KFl affects the design loads that are applied in the add-on module, which are the
following:
• Load due to weight of foundation plate
• Load due to self-weight of bucket
• Load due to earth covering
• Load due to additional loading
The factor applicable to actions for reliability differentiation KFl and the consequences class CC
are documented in the results windows of FOUNDATION Pro. You can look at them under the
entry Resulting Partial Factor:

Figure 7.7: Output of consequences class in FOUNDATION Pro

If you choose in FOUNDATION Pro a national annex involving a factor KFl that is different from
the one specified in RSTAB, you are notified before the calculation starts.

Figure 7.8: RSTAB message before calculation

Example :
Standard in RSTAB:

EN 1990 + NA for Sweden => KFl = 0.91

Standard in FOUNDATION Pro:

EN 1992-1-1 + EN 1997-1

=> KFl = 1.00

The factor KFl = 0.91 from RSTAB will be used for the designs carried out in FOUNDATION Pro.

66

Program FOUNDATION Pro © 2014 Dlubal Software GmbH

7 General Functions

7.4

Export of Results

The results of the foundation design can also be used in other programs.

Clipboard
To copy cells selected in the module's results windows to the clipboard, use the keyboard keys
[Ctrl]+[C]. To insert the cells, for example in a word processing program, press [Ctrl]+[V]. The
headers of the table columns are not transferred.

Printout report
The FOUNDATION Pro data can be printed in the printout report (see Chapter 6.1, page 60)
from where they can be exported by selecting
File → Export to RTF.
Exporting to VCmaster is also possible. The corresponding functions are described in Chapter
10.1.11 of the RSTAB manual.

Excel / OpenOffice
FOUNDATION Pro provides a function used for the direct data export to MS Excel and OpenOffice.org Calc or the export in the file format CSV. To access the corresponding function, use
the FOUNDATION Pro menu and select
File → Export Tables.
The following export dialog box appears.

Figure 7.9: Dialog box Export of Tables

Having selected the relevant options, you can start the export by clicking [OK]. Excel or OpenOffice are started automatically, that is, you do not need to open the programs beforehand
(see following figure).
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Figure 7.10: Result of export to Excel

CAD programs
The reinforcement drawings generated in FOUNDATION Pro can also be used in CAD applications. It is possible to export the drawings as DXF files. To access the corresponding function,
use the FOUNDATION Pro menu and select
File → DXF Export of Reinforcement Drawings.
The Windows dialog box Save As opens where you enter the directory and name of the DXF file.
Then, you can set the export content including drawings, dimensions and layers in the dialog
box DXF Export of Reinforcement Drawings.

Figure 7.11: Dialog box DXF Export of Reinforcement Drawings
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8.

Examples

8.1

Bucket Foundation

In this example, a reinforced bucket is designed with a rough formwork surface for a group of
load cases whose internal forces result in biaxial bending stress. Enclosing links are chosen for
the reinforcement.

8.1.1

Support Forces

The support forces for the defined loading is determined in RSTAB. The following load cases
are governing for the design of a bucket foundation with rough formwork:
Load case maxHtX

The internal forces of this load case result in the maximum horizontal
force in the X-direction.

Load case maxHtY

The internal forces of this load case result in the maximum horizontal
force in the Y-direction.

Load case minT

The internal forces of this load case lead to the greatest minimum
embedment depth of the column in the bucket.

FOUNDATION Pro finds out which load case or combination provides the governing support
reactions for the design.
The internal forces of the following load cases are available for the ultimate and the serviceability limit state design:
Load Case

PZ,d [kN]

PX,d [kN]

PY,d [kN]

MX,d [kN]

MY,d [kN]

1

300

-50

20

100

250

2

100

0

0

0

327

3

500

0

0

150

-150

Load Case

PZ,k [kN]

PX,k [kN]

PY,k [kN]

MX,k [kN]

MY,k [kN]

4

215

-35

14

75

175

5

75

0

0

0

235

6

360

0

0

110

-110
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8.1.2

Other Settings

The following boundary conditions apply to the design performed in FOUNDATION Pro:
•

Foundation type

bucket foundation with rough bucket sides

•

Column

rectangle 30 cm / 40 cm

•

Standards

EN 1992-1-1, EN 1997-1

•

Design section

column center

•

Link shape

links enclosing the column

•

Concrete

C 35/45

•

Reinforcing steel:

B 500 S (A)

•

Concrete cover

minimum concrete cover according to standard
(exposure class XC2/XC3, concrete cast against prepared ground)

Figure 8.1: Details dialog box for concrete cover
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•

Eccentricity in x-direction

–30 cm (distance from column center to center of
foundation plate)

•

Eccentricity in y-direction

none

•

Earth covering

1.00 m with specific weight of earth covering = 20 kN/m3

•

Additional concentrated load

17 kN

•

Distance from support coordinate system
- in x-direction

-0.5 m

- in y-direction

0.5 m

•

Additional uniformly distributed load

•

Distance of distributed load start from support coordinate system
- in x-direction

1.5 m

- in y-direction

1.5 m
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•

Distance of distributed load end from support coordinate system
- in x-direction

-2.0 m

- in y-direction

-2.5 m

•

Allowable soil stress σRk

•

No consideration of passive earth resistance for design of safety against sliding

•

Undrained conditions

8.1.3

280 kN/m²

Dimensions of Foundation Plate and Bucket

The Rate parameters of the foundation plate must be defined as follows:

Figure 8.2: Details dialog box for dimensioning of foundation plate
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The following dimensions of the foundation plate and the bucket are determined during the
iterative calculation:

Figure 8.3: Result of dimensioning process

As users expect the dimensions of the foundation to be rounded to centimeters, FOUNDATION
Pro provides a button next to the displayed dimensions which you can use to import the calculated dimensions to Window 1.2. Then, you can enter the desired dimensions.

Figure 8.4: Buttons [Import Dimensions]
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Figure 8.5: Rounded dimensions of foundation

8.1.3.1

Minimum Embedment Depth of Column

The load case LC1 or LC2 (both load cases with ex > 2.0) is governing for the determination of
the first embedment depth d1 of the column embedded in the bucket. The eccentricity e is the
result of:

ex =

M
250.00
=
= 2.083
Pz ⋅ c 300.00 ⋅ 0.40

As 2.0 < 2.083, the required embedment depth req d is determined with the following result:

req d = min T1 = 2 ⋅ c = 2 ⋅ 40 = 80 cm

Figure 8.6: Verification of minimum embedment depth for LC1
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Figure 8.7: Verification of minimum embedment depth for LC2

8.1.4

Horizontal Forces on Bucket Walls

As an example, the largest horizontal force in the y-direction is determined as a force acting
perpendicular on the bucket wall in the x-direction:

max Hty =

6 ⋅ MX 6
6 ⋅ 150 6
+ ⋅ PY =
+ ⋅ 0 = 137.40 kN
5⋅ t
5
5 ⋅ 1.31 5

In the results window 2.3 Required Reinforcement, you find the same value listed among the detailed results. There, you can also see the corresponding horizontal force in the x-direction acting perpendicular on the bucket wall in the y-direction.

Figure 8.8: Maximum horizontal force in the y-direction

The next detail entry shows the results of the load case resulting in the largest horizontal force
in the x-direction acting perpendicular on the bucket wall in the y-direction. The corresponding horizontal force in the y-direction acting perpendicular on the bucket wall in the xdirection is displayed here, too.

Figure 8.9: Maximum horizontal force in the x-direction
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8.1.5

Tensile Forces of Links and Link Reinforcement

8.1.5.1

Horizontal Bucket Links Lh (outside all sides)

There are the following tensile forces in the load case with the maximum horizontal force in
the y-direction:

Figure 8.10: Maximum tensile force in horizontal bucket links – load case with greatest horizontal force in the y-direction

The tensile forces in the load case with the maximum horizontal force in the x-direction are:

Figure 8.11: Maximum tensile force in horizontal bucket links – load case with greatest horizontal force in the x-direction
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On the outside of the bucket, the tensile forces acting on the entire reinforcing steel resulting
from the bucket wall's bending are marked out. Above the sketched link, you can see the proportional tensile force due to bending falling upon the horizontal bucket link. The proportional
tensile force due to tension of the respective bucket wall is added to this force.
Before the governing tensile force is determined, we want to have a look at the proportional
tensile force due to bending in the horizontal bucket link lying outside on all sides. Here, the
bending of the bucket wall in the y-direction, which is available in the load case with the largest horizontal force in the x-direction, is regarded.
First, the acting bending moment must be determined.

Figure 8.12: Acting bending moment

The lever arms a2, a3 and a4 are determined as follows:

a2 , y =
a3 ,y =
a 4 ,y =

cy
4
cy
2
cy
2

=

30
= 7.5 cm
4

+ a ty + nom c k +

ds 30
1.4
=
+ 10 + 7.0 +
= 32.7 cm
2
2
2

+ a + t ty − nom c k −

ds 30
1.4
=
+ 10 + 37 − 7 −
= 54.3 cm
2
2
2

Now, it is possible to determine the acting moment under the characteristic load around the
point P as follows.

max Htx
 max Htx

MEd,y = γ ⋅ 
⋅ ( a3,y + a 4 ,y ) −
⋅ a2 ,y 
4
2


299.54
 299.54

= 1.0 ⋅ 
⋅ (0.327 + 0.543) −
⋅ 0.075  = 53.92 kNm
2
 4
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The following figure shows the parameters of the bending design carried out in the program.

Figure 8.13: Details – horizontal bucket links

The height of the compression zone is composed of a triangular and a rectangular compression
zone part. The factor 0.8 from the formula below is omitted above because the height has already been reduced by this factor. The heights of the compression zones result from the design.
Find details about the concrete design in Chapter 8.1.6 describing how the safety against
bending failure is determined.
Now, in order to determine the proportional tensile force falling upon the horizontal bucket
link, the lever arms a5 and a6 must be determined first.

ds 0.8 ⋅ z Du
d
0.8 ⋅ (h T + hR )
−
= t tx − nom c k − s −
2
4
2
4
1.4 1.7 + 2.5
= 27 − 7 −
−
= 18.25 cm
2
4

a5,y = t tx − nom c k −

a 6 ,y =

cy
8

+ a ty + t ty − nom c k −

ds 30
1.4
=
+ 10 + 37 − 7 −
= 43.05 cm
2
8
2

Finally, the load spreading angle θ1 can be determined.

θ1 = arctan

a5
18.25
= arctan
= 22.97
a6
43.05

By using the angle and the quarter-point of the applied proportional horizontal force max HtX,
it is possible to determine the value for the force of the concrete compression strut D1.

D1 =

max HtX
299.54
=
= 191.89 kN
4 ⋅ sin s1 4 ⋅ sin 22.97

The horizontal component of the compression strut force D1 is the proportion of the complete
tensile force that results from the bucket wall's bending in the y-direction:

TLh,Bend = D1⋅ cos s1 = D1⋅ cos s1 = 191.89 ⋅ cos 22.97 = 176.65 kN
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This tensile force can also be found in the details of FOUNDATION Pro.

Figure 8.14: Details – geometric values to allocate the tensile force

Having this background information, it is now possible to understand how the maximum
tensile force in the horizontal bucket link is determined. It results from the bucket wall's
bending in the y-direction due the maximum horizontal force that is available in the xdirection:

gov TLh = 176.65 kN
As we have a steel strain that is beyond the steel strain available on the yield strength, the
yield strength is used as the prevailing steel stress for the determination of the required
reinforcement area. In the program, it is displayed as follows:

Figure 8.15: Details – required reinforcement area for links

The following reinforcement is chosen:

Figure 8.16: Rendering of horizontal bucket links

78

Program FOUNDATION Pro © 2014 Dlubal Software GmbH

8 Examples

The table below offers an overview of the reinforcement details.

Figure 8.17: Details – selected reinforcement (links Lh)

8.1.5.2

Horizontal Bucket Links LhY (in y-direction outside)

The tensile force in the links lying on the outside of the bucket walls in the y-direction is to be
determined in the same way.
There are the following tensile forces in the load case with the maximum horizontal force in
the y-direction:

Figure 8.18: Maximum tensile force in link lying outside (y-direction) – load case with greatest horizontal force in the
y-direction
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There are the following tensile forces in the load case with the maximum horizontal force in
the x-direction:

Figure 8.19: Maximum tensile force in link lying outside (y-direction) – load case with greatest horizontal force in the
x-direction

The largest tensile force occurs due to the bending of the bucket wall in the y-direction, which
is available in the load case of the maximum horizontal force in the x-direction:

gov TLhY = 115.12 kN
Then, the following reinforcement area for the links LhY is determined:

Figure 8.20: Details – required reinforcement area for links LhY

The following reinforcement has been chosen:

Figure 8.21: Rendering of link reinforcement LhY
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The following design specifications can be found in the reinforcement details.

Figure 8.22: Details – selected reinforcement (links LhY)

8.1.5.3

Horizontal Bucket Links LhX (in x-direction outside)

The link reinforcement lying outside in the x-direction is determined in a similar way.

Figure 8.23: Rendering of link reinforcement LhX

Figure 8.24: Details – selected reinforcement (links LhX)
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8.1.5.4

Vertical Bucket Links Lvx

To determine the vertical edge reinforcement of the bucket wall in the x-direction, the load
case resulting in the maximum horizontal force in the x-direction is considered.

Figure 8.25: Distribution of horizontal force to bucket walls

The horizontal force is uniformly distributed to both bucket walls:

max Tht ,x = 149.77 kN
The inclination of the concrete compression strut running diagonally across the bucket wall
in the x-direction is determined as follows:

Figure 8.26: Model of forces for determination of vertical side tensile force

tan α =

109.17
= 1.309
83.4

Now, the side tensile force can be determined:

max Tvt ,x = tan α ⋅ max Tht ,x = 1.309 ⋅ 149.77 = 196.04 kN
Then, the total reinforcement area required for the absorption of the tensile forces is
determined.

req As =

fyd =

82

max Tvt ,x
196.04
=
= 4.509 cm2
fyd
43.4783

500000 kPa
= 43.4783 kN / cm2
1.15
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Now, if the total reinforcement area is divided by twice the area of a vertical link, we get the
required number of vertical links.
Thus, links with a diameter of Ø 12 mm are chosen.

req n =

req As
4.509
=
= 1.99
2 ⋅ Aslinks 2 ⋅1.13

There are two links selected for each side of the bucket wall in the x-direction. So we get the
following reinforcement:

Figure 8.27: Rendering of link reinforcement Lvx

In the tables, the reinforcement is displayed as shown below:

Figure 8.28: Details – selected reinforcement (links Lvx)
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8.1.5.5

Vertical Bucket Links Lvy and Bucket Wall Reinforcement

The edge reinforcement for the bucket wall in the y-direction is determined in the same way.
The result is the following:

Figure 8.29: Details – selected reinforcement (links Lvy)

The edge reinforcements are coupled with the bending reinforcement of the foundation plate.
Thus, the determination of the statically required reinforcement is complete.
For structural reasons, it is now necessary to insert in each wall as many links as allowed by the
spacing of 20 cm selected in module window 2.6 Bucket Reinforcement for the bucket wall reinforcement in the x- and y-direction.

Figure 8.30: Rendering of bucket wall reinforcement in the x- and y-direction
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8.1.6

Safety Against Bending Failure of Bucket Wall

The following chapters describe further design details.

Acting moment M
The acting moment under characteristic load is M = 53.92 kNm for the bending of the bucket
wall in the y-direction due to the maximum horizontal force in the x-direction.

Ultimate moment MEd
The calculated load moment corresponds to the ultimate moment MEd = 53.92 kNm.

Moment capacity MRd
Shortening on the inner side and elongation on the outside of the bucket wall in the ydirection are changed iteratively until the forces in the steel and in the concrete coming along
with these deformations form together with their distance an internal moment MRd that is
larger than the ultimate moment MEd.
After specifying a reinforcement area, it is once again possible to determine an internal moment MRd. Starting from the state of ultimate strain at failure, the deformation of steel and
concrete is changed until an equilibrium of forces is established in both materials. Now, we
want to determine this moment capacity MRd for the selected reinforcement.
At the end of the iterations, there is the following result:

Figure 8.31: Moment capacity MRd,y
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The following two sketches illustrate the parameters of the moment capacity MRd.

Figure 8.32: State of strain when internal forces are balanced

Figure 8.33: Shape of compression zone (section through bucket wall with view in the y-direction)

If the moment capacity MRd = 61.01 kNm is divided by the previously determined design
moment MEd=53.92 kNm, we get the safety against bending failure that is available with
the selected reinforcement.

Figure 8.34: Determination of safety against bending failure

The provided safety against bending failure can be further increased if the number of the links
outside in the y-direction is increased from 2 to 3 links which are structurally possible. The internal moment MRd and the provided safety against bending failure are the following after performing the recalculation:

Figure 8.35: Safety against bending failure after changed reinforcement
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8.1.7

Concrete Stresses in Bucket Walls

The design of concrete stresses in the bucket walls is performed by a comparison of the stresses σc,top with the design value of the concrete compression strength fcd for the concrete of the
foundation. The design is carried out according to [1] 10.9.6.
The following figures illustrate the correlations.

Figure 8.36: Impact of horizontal forces on bucket walls

σ c ,t ,x =

(

H t ,x

t
⋅ dky − 2 ⋅ t ty
3

)

=

299.54
= 1371.9 kPa
1.31
⋅ (1.24 − 2 ⋅ 0.37 )
3

σ c ,t ,x ≤ fcd
1371.9 kPa ≤ 19833.3 kPa
Criterion:

1371.9
= 0.069 < 1
19833.3
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8.1.8

Lap Length of Bucket Reinforcement

In particular cases, the governing bucket height can be determined by the lap length design
according to [1] 8.7.3. Here, this design is performed by using the governing load in the xdirection from LC 2.
Distance of column longitudinal reinforcement:

z x = MIN[0.9 ⋅ (c x − dc ); c x − 2 ⋅ dc ] = MIN[0.9 ⋅ ( 400 − 50 ); 400 − 2 ⋅ 50] = 300mm
Moment:

c

 0.4

− 0.05  = 342 kNm
MED ,x = My + Pz ⋅  x − dc  = 327 + 100 ⋅ 
 2

 2

Column tension force:

Ft ,x =

MED ,x
342
− Pz =
− 100 = 1040 kN
zx
0.3

Column compression force:

M
Fp ,x = − ED ,x
 zx


342 
 = −
 = −1140 kN
0.3 



(

)

Fx = MAX Ft ,x ; Fp ,x = MAX(1040 ; −1140 ) = 1040 kN
Design value of concrete tension strength:

fctd = c ct ⋅ fctk 0 ,05 ⋅

1
1
= 1⋅ 2200 ⋅
= 1466.7 kPa
χc
1.5

Design value of ultimate bond stress according to [1] 8.4.2:

fbd = 2.25 ⋅ η1 ⋅ η2 ⋅ fctd = 2.25 ⋅ 1⋅ 1⋅ 1466.7 = 3300 kPa
where
η1 = 1.0

quality of bond conditions and position of bars during concreting
- "good" bond conditions

η2 = 1.0

factor for taking account of bar diameter – Ø ≤ 32 mm

Column tension force in reinforcement LVx:

Fs ,x = Fx ⋅

zx

t
z x + dc + a tx + tx
2

0.3

= 1040 ⋅

0.3 + 0.05 + 0.1+

0.27
2

= 533.33 kN

Available steel stress:

σx =

Fs ,x
533.33
=
= 437.54 MPa
A sx 0.001219

The required basic value of the anchorage length lb,rqd used to anchor the force As · σsd of a
straight member, under the assumption of a constant bond stress fbd, results from:

lb ,rqd,x =

88

φ x σ x 0.012 43754
⋅
=
⋅
= 0.398 m
4 fbd
4
3300
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Minimum lap length:

l0 ,min,x = MAX(0.3 ⋅ α 6 ,x ⋅ lb ,rqd,x ;15 ⋅ φ x ; 0.2) = MAX(0.3 ⋅ 1.5 ⋅ 0.398 ; 15 ⋅ 0.012; 0.2) = 0.20 m
Lap length:

l0 ,x = α1 ⋅ α 6 ⋅ lb ,rqd,x = 1.0 ⋅1.5 ⋅ 0.398 = 0.597 m
where

α1 = 1.0
α6 = 1.5 (percentage of lapped bars relative to total area of reinforcing steel > 50%)
Design of lap length:

l0 ,x ≥ l0 ,min,x
0.597 m ≥ 0.20 m
Required embedment depth in the x-direction:

t min,x = c k +

8.1.9

t tx
φ
0.27
0.012
+ l0 ,x + x + a tx + 2 ⋅ d c = 0.07 +
+ 0.597 +
+ 0.1 + 2 ⋅ 0.05 = 1.008 m
2
2
2
2

Soil-Mechanical Designs

For the soil-mechanical designs we determine the resulting loads in the soil joint, which is the
transition zone between the ground and the concrete below the foundation, without support
forces.
First, the volume of the bucket is calculated.

Vbucket = (c x + 2 ⋅ ( t tx + a tx )) ⋅ (c y + 2 ⋅ ( t ty + a ty )) ⋅ h
= (0.40 + 2 ⋅ (0.27 + 0.10 )) ⋅ (0.30 + 2 ⋅ (0.37 + 0.10 )) ⋅1.31 = 1.8518 m3
Now, the bucket's self-weight can be determined.

G cal, d = 25 ⋅ 1.8518 = 46.30 kN
Then, the weight of the earth covering, which is on the contact area of the bucket, must be
calculated.

(

)

Gcov,d = x ⋅ y − (c x + 2 ⋅ ( t tx + a tx )) ⋅ (c y + 2 ⋅ ( t ty + a ty )) ⋅ c ⋅ γ

= (3.3 ⋅ 2.6 − (0.40 + 2 ⋅ (0.27 + 0.10 )) ⋅ (0.30 + 2 ⋅ (0.37 + 0.10 )))⋅1.0 ⋅ 20 = 143.33 kN
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In this context, we want to clarify how the resultant of an additional load that is uniformly distributed is determined: You specify the start and end of the uniformly distributed load. Then,
FOUNDATION Pro determines the part of the load lying on the foundation plate when the dimensioning is done. The following sketch demonstrates this principle.

Figure 8.37: Uniformly distributed load across foundation plate

The uniformly distributed load cuts the edges of the foundation plate, stressing only a part of
the foundation. The length of this load component can be calculated by means of the coordinates of the start and end point. Then, the value is multiplied by the distributed load per meter
(10 kN/m). Thus, the resultant force of 34.55 kN is the result.
The design details of FOUNDATION Pro are shown below.

Figure 8.38: Details - determination of resultant force of an additional uniformly distributed load

In the details, the loads are summarized as follows:

Figure 8.39: Details - resulting loads in soil joint from permanently acting loads

After those preliminary calculations, it is possible to perform the soil-mechanical designs.
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8.1.9.1

Proof of Safety for Uplift Limit State

There are no lifting column axial forces available. Therefore, the design according to [2] 2.4.7.4
is not carried out.

8.1.9.2

Proof of Safety for Ground Failure

The load combination CO3 is governing for ground failure analysis according to [2] 6.5.2. The
resulting vertical force in the soil joint is determined from the column axial force and the already determined permanent loads with:

V `d = 929.83 kN
The resulting moment in the soil joint for the reinforcement running in the x-direction is determined from the loads represented in Figure 8.40.

res M x ,d = M Y ,d − PX ,d ⋅ (d + h) − ΣPN,d ⋅x N −ΣPL ,d ⋅ x L − ex ⋅ (PZ ,d + G cal,d − ∆G cov,d − R p )
= −150.00 − 0.00 ⋅ (0.36 + 1.31) − 17 ⋅ 1.35 ⋅ ( −0.2) − 34.55 ⋅ 1.35 ⋅ 0.488
− 0.30 ⋅ (500 + 46.30 ⋅ 1.35 − 28.272 ⋅ 1.35)
= −325.45 kNm

Figure 8.40: Loads and resulting moment in soil joint

The moment in the soil joint for the reinforcement in the y-direction is calculated as follows:

res M y ,d = M y + PY ,d ⋅ (d + h) − ΣPN,d ⋅y N −ΣPL ,d ⋅ y L − e y ⋅ (PZ ,d + G cal,d − ∆G cov,d − R p )
= 150.00 + 17 ⋅ 1.35 ⋅ 0.5 + 34.55 ⋅ 1.35 ⋅ 0 = 161.48 kNm
Based on both moments in the soil joint, it is possible to determine the eccentricity of the
resulting vertical force in the respective directions.

ex = −
ey =

res M x ,d
− 325.45
=−
= 35.0 cm
Vd
929.83

res M y ,d
Vd

=

161.48
= 17.37 cm
929.83
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The eccentricities are used to calculate the effective foundation side lengths.

L `= x − 2 ⋅ e x = 3.3 − 2 ⋅ 0.35 = 2.60 m

B`= y − 2 ⋅ e y = 2.6 − 2 ⋅ 0.174 = 2.252 m
This results in an effective foundation area Aeff of:

A `= L `⋅ B`= 2.60 ⋅ 2.253 = 5.857 m²
Now, we can determine the provided soil contact pressure.

σ prov =

V `d 929.83
=
= 158.8 kN / m2
A`
5.857

Figure 8.41: Provided soil stress

The design of the allowable soil stress is fulfilled:

σRd =

σRk 280
=
= 200.0 kN / m2
γR , v ` 1.4

σprov ≤ σRd
158.8 kN / m2 ≤ 200.0 kN / m2
Thus we obtain the following design criterion:
Criterion:

92

σprov
σRd

=

158.8
= 0.794 < 1
200.0
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8.1.9.3

Proof of Safety for Loads with Large Eccentricities

The load case LC5 is governing for the design according to [2] 6.5.4. The resulting vertical force
in the soil joint is determined from the column axial force in connection with the already determined permanent loads as follows:

res Vk = 393.39 kN
Thus, the resulting moment in the soil joint for the reinforcement running in the x-direction results from the following loading:

res M x ,k = M y − Px ⋅ (d + h) − ΣPN,d ⋅x N −ΣPL ,d ⋅ x S − e x ⋅ (Pz + G cal,d − ∆G cov,d − R p )
= 235.00 − 17 ⋅ ( −0.2) − 34.55 ⋅ 0.4875 − 0.30 ⋅ (75 + 46.30 − 28.27)
= 193.65 kNm
The moment in the soil joint for the reinforcement in the y-direction is calculated as follows:

res M y ,k = M x + Py ⋅ (d + h) + ΣPN,d ⋅y N +ΣPL ,d ⋅ y S + e y ⋅ (Pz + G cal,d − G cov,d − R p ) = 17 ⋅ 0.5
= 8.50 kNm
The eccentricities of the resulting vertical force in the respective directions are:

e `x =

e `y =

res M x ,k
193.65
=−
= 0.492 m
res Vk
393.39
res M y ,k
res Vk

=

8.50
= 0.022 m
393.39

The maximum eccentricity must not exceed:

1
1
e all = ⋅ B = ⋅ 330 cm = 110 cm
3
3
The following figure shows the position of the resulting vertical force in the soil joint:

Figure 8.42: Position of resultant

The design for the loads with large eccentricities is fulfilled:

e `x ≤ e all
0.492 ≤ 1.1
Thus we obtain the following design criterion:
Criterion:

e `x 0.492
=
= 0.447
e all
1.1
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8.1.9.4

Proof of Safety for Sliding

The load case LC1 is governing for the sliding design according to [2] 6.5.3. The shear force,
which is governing for the design under undrained subsoil conditions, is:

Hx ,d = 50 kN
The soil resistance is determined as follows:

R s = A `⋅c u,d = 5.51⋅10 = 55.1kN
Thus, we obtain the following design criterion for the governing x-direction.
Criterion:

8.1.9.5

Hx ,d 50.0
=
= 0.998
R x ,d 55.1
1.1

Proof of Equilibrium Limit State

The load case LC2 is governing for the equilibrium limit state design according to [2] 2.4.7.2.
The resulting moments on the four edges of the soil joint are determined from the column axial
force together with the already determined permanent loads. Here, it is necessary to consider
the effect which comes from the moments:
•

Destabilizing effect

•

Stabilizing effect

In load case 2, only the following moment is acting in a destabilizing way on edge 3:

M dst ,3 = M y ,d = 327.00 kN
The moments acting in a stabilizing way are reduced by partial safety factors.
Moment from RSTAB:

x

M x ,RSTAB ,d = Pz ,d ⋅  + e x  = 100 ⋅ (1.65 + 0.3) = 195.0 kN
2


Moment from plate weight:

x
M x ,p ,d = Gp ,d ⋅ ⋅ γ G ,stb = (3.3 ⋅ 2.6 ⋅ 0.36 ⋅ 25)⋅1.65 ⋅ 0.9 = 114.67 kN
2
Moment from bucket self-weight:

M x ,cal,d = (G cal,d ⋅ (x / 2 + e x ))⋅ γ G ,stb = (1.14 ⋅ 1.24 ⋅ 1.31⋅ 25 ⋅ (1.65 + 0.3)) ⋅ 0.9 = 81.25 kN
Moment from cover:

M x ,cov,d = (x ⋅ y ⋅ c ⋅ γ c ,k ⋅ x / 2 ) / (dkx ⋅ dkz ⋅ c ⋅ γ c ,k ⋅ (x / 2 + e x ))⋅ γ G ,stb

= ((3.3 ⋅ 2.6 ⋅1⋅ 20 ⋅1.65) / (1.14 ⋅1.24 ⋅1⋅ 20 ⋅ (1.65 + 0.3)))⋅ 0.9 = 205.21kN

Design value of moment from additional single loads:

M x ,N,d = (G Z ,1 ⋅ (x / 2 + (x N1 + e x )))⋅ γ G,stb = (17 ⋅ (1.65 + (/ 0.5 + 0.3))) ⋅ 0.9 = 22.185 kN
Design value of moment from additional line loads:

M x ,L ,d = (GL ,1 ⋅ (x / 2 + x S(L1) ))⋅ γ G ,stb = (34.55 ⋅ (1.65 + 0.4875)) ⋅ 0.9 = 66.46 kN
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Stabilizing moment acting on edge 3:

M stb,3 = M x ,RSTAB ,d + M x ,p ,d + M x ,cal,d + M x ,cov,d + M x ,N,d + M x ,L ,d
= 195.0 + 114.67 + 81.25 + 205.21+ 22.185 + 66.46
= 684.78 kNm
Thus we obtain the following design criterion:

Criterion3 =

M dst ,3
327.0
=
= 0.478
M stb ,3 684.78

8.1.10 Design of Internal Stability
8.1.10.1 Safety Against Bending Failure of Foundation Plate
The foundation plate has top and bottom reinforcement for each direction. So, four different
safeties against bending failure must be designed.

Safety against bending failure from bottom reinforcement in x-direction
First, it is necessary to determine the design moments for the bending design of the foundation plate from the governing soil contact pressure. The load case LC1 is governing for the bottom reinforcement in the x-direction.
The resulting vertical force in the soil joint is determined from the column axial force in connection with the already determined permanent loads as follows:

res Vmax = 729.83 kN
Thus, the resulting moment in the soil joint for the reinforcement running in the x-direction results from the following loading:

res M x ,d = M y − Px ⋅ (d + h) − ΣPN,d ⋅x N −ΣPL ⋅ x S − e x ⋅ (Pz + G cal,d − ∆G cov,d − R p )
= 250.00 − ( −50.00 ) ⋅ (0.36 + 1.31) − 17 ⋅1.35 ⋅ ( −0.2) − 34.55 ⋅1.35 ⋅ 0.4875
− 0.30 ⋅ (300 + 46.30 ⋅1.35 − 28.27 ⋅1.35) = 218.05 kNm
The moment in the soil joint for the reinforcement in the y-direction is calculated as follows:

res M y ,d = M x + Py ⋅ (d + h) + ΣPN,d ⋅y N +ΣPL ⋅ y S + e y ⋅ (Pz + G cal,d − ∆G cov,d − R p )
= 100 + 20.00 ⋅ (0.36 + 1.31) + 17 ⋅ 1.35 ⋅ 0.5 = 144.88 kNm
The eccentricities of the resulting vertical force in the respective directions are:

ex = −

ey =

res M x ,d
218.05
=−
= −29.88 cm
res Vmax
729.83

res M y ,d
res Vmax

=

144.88
= 19.85 cm
729.83
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Iteratively, the following distribution of compression stress is the result. The value and position
of the resultant corresponds to the resulting vertical force in the soil joint.

Figure 8.43: Distribution of compressive stress

Figure 8.44: Distribution of compressive stress displayed in table

Now, the volume of the partial compressive stress object and its distance to the center of gravity is determined by the user-defined design section. The product of both values provides the
moment due to the compression stress.
The figure below illustrates the design section indicated by arrows showing in the direction of
the partial compressive stress object by which the moment due compression stress has been
determined. The moment MC,x,plus = 121.90 kNm in the positive x-direction results from this
compressive stress block.

Figure 8.45: Moment from compressive stress block in the positive x-direction
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Figure 8.46 shows the design section for the moment from compressive stress in the negative
x-direction, providing the moment MC,x,minus = 558.74 kNm.

Figure 8.46: Moment from compressive stress block in the negative x-direction

In the Details dialog box, the design section was placed into the column center according to
the specification on page 70.
Next, we have to subtract the component causing no bending of the plate from both moments. It is composed of the foundation plate's self-weight and the earth covering (see the following figures).
In Figure 8.47, the distance from the design section to the plate edge in the x-direction is 1.35
m. Thus, the moment from self-weight and earth covering is calculated with:

M A ,x ,plus =

1.352
1.352
⋅ 2.6 ⋅ γ G ⋅ (d ⋅ γ concrete + cov⋅ γ cov ) =
⋅ 2.6 ⋅ 1.35 ⋅ (0.36 ⋅ 25 + 1⋅ 20 ) = 92.76 kNm
2
2

Figure 8.47: Moment from area load in the positive x-direction

In Figure 8.48, the distance from the design section to the negative plate edge in the xdirection is 1.95 m. Thus, the self-weight and the earth covering are calculated with:
M A ,x ,minus =

1.952
1.952
⋅ 2.6 ⋅ i G ⋅ (d ⋅ i concrete + cov⋅ i cov ) =
⋅ 2.6 ⋅ 1.35 ⋅ (0.36 ⋅ 25 + 1⋅ 20 ) = 193.53 kNm
2
2

Figure 8.48: Moment from area load in the negative x-direction
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Consequently, the following design moments are available in the respective section directions:

Mbottom,x ,plus = M C ,xplus + M G ,xplus = 121.90 − 92.76 = 29.14 kNm

Mbottom,x ,minus = M C ,x minus + M G ,x minus = 558.74 − 193.53 = 365.21 kNm
This is the direction where the plate gets tension on the bottom side. Thus, a bottom bending
reinforcement is required. The design moment in the positive x-direction is governing for the
design of a bottom bending reinforcement.

M x ,b = Mbottom,x ,minus = 365.21 kNm
Now, the foundation plate is subdivided into eight strips of the same width in the x-direction.
Using the following quotient, we find out how large is the proportion of the design moment
that is allocated to each plate strip.

Qx =

(

)

c x + 2 ⋅ a tx + t tx
0.40 + 2 ⋅ (0.10 + 0.27 )
=
= 0.35
x
3.3

As the quotient is larger than 0.3, the design moment is uniformly distributed to all eight plate
strips. Thus, the distribution factor α is 0.125.
The proportional design moment for the plate strip No. 4 is:

MEd,x , 4 = α ⋅ M x ,b = 0.125 ⋅ 365.21 = 45.65 kNm
FOUNDATION Pro uses the following parameters to determine the moment capacity MRd:

Figure 8.49: Details - parameters for determination of moment capacity

The required steel of this plate strip is determined based on the required reinforcement
tension force and the provided steel stress for the given state of strain.

req A X , 4 =

98

Fsd 193.50
=
= 4.280 cm2
σ s 45.214
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Now, the amount of steel is related to one meter of standard length.

req aX , 4 =

req A X , 4 4.280
=
= 13.17 cm2 / m
y strip
0.325

This required reinforcement can be covered most efficiently by using bars of Ø 10 mm placed
in a distance of 80 mm and a mesh reinforcement of Q 335A.

Figure 8.50: Details - reinforcement specifications for bottom zone in the x-direction

In module window 2.4, the reinforcement is changed manually to bars of Ø 16 mm with a
spacing of 200 mm:

Figure 8.51: Details - changed reinforcement specifications for bottom zone in the x-direction

In addition to the mat Q 335A, the rendering represents these rebars inserted in the x- and ydirection as follows:

Figure 8.52: Rendering of bottom reinforcement
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As the quantity and the position of the inserted reinforcement area is known, the moment
capacity MRd is again determined. The result is the following:

Figure 8.53: Details - parameters for determination of moment capacity

With the changed reinforcement we get the following existing safety against bending failure:

exis i x , 4 =

MRd,x , 4 50.19
=
= 1.10
MEd,x , 4 45.65

Thus, the design criterion for the design of the plate's safety against bending failure for the
bottom reinforcement in the x-direction is the following:
Criterion:

req i
1.0
=
= 0.909
exis i x , 4 1.10

Safety against bending failure from bottom reinforcement in y-direction
The calculation steps are the same as for designing the safety against bending failure from the
bottom reinforcement in the x-direction.
The most efficient reinforcement proposal includes the mesh reinforcement Q 335A and rebars
of Ø 12 mm with a spacing of 220 mm. This rebar spacing is changed to 200 mm in module window 2.4. So, we get the following design result:

Figure 8.54: Details - safety against bending failure from bottom reinforcement in the y-direction
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Safety against bending failure from top reinforcement in x-direction
The design is carried out as already described above. A particular case, however, is the determination of the design moment. In the governing load case LC2, the following compressive
stress block from the maximum moment is formed below the plate:

Figure 8.55: Distribution of compressive stress

The moment from the compressive stress block part in the positive x-direction is MC,x,plus = 35.48
kNm. The moment from the area load in the positive x-direction is MA,x,plus = -92.76 kNm.
Furthermore, we have to consider the resultant of the additional single or line loads running
across the plate. This resultant force lies beyond the design section in the positive x-direction.

Figure 8.56: Additional uniformly distributed loads

So, we get a top bending moment of MZ,x,plus = -7.98 kNm from the additional loading.
The design moment for the top reinforcement in the x-direction is determined from the sum of
these moments:

M x ,t = M C ,x ,plus + M A ,x ,plus + M Z , x ,plus = 35.48 − 92.76 − 7.98 = −65.26 kNm
For the top reinforcement the design moment is uniformly distributed to the eight design
strips. Thus, the following reinforcement is the result:

Figure 8.57: Details – top reinforcement in the x-direction
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On the basis of this reinforcement, the design of the safety against bending failure is performed.

Figure 8.58: Details - safety against bending failure from top reinforcement in the x-direction

Safety against bending failure from top reinforcement in y-direction
The safety against bending failure in the y-direction is determined in the same way. However,
as there is no bending moment available, reinforcement is not required.

8.1.10.2 Punching Resistance of Foundation Plate
For the punching shear design according to [1] 6.4 it is necessary to determine the shear force
transferring area, first.
The expected distance from the bucket edge to the perimeter was user-defined with the value
lw,def = 1.0 · d = 26 cm for the determination of the foundation's minimum dimensions. In addition, the iterative calculation of the critical perimeter was set. The factor used to consider the
favorably acting soil stresses within the perimeter is set with kred = 1.00. This means that 100 %
of the soil stresses within the perimeter have been considered as favorably acting for the determination of the resulting applied shear force VEd,red.
All three load cases lead to similar design criteria. Two different types of verification are relevant:
•

Double-sided edge column: shear force design for LC2

•

Interior column: punching shear design for LC1 and LC3

In order to analyze the results in the results windows of the add-on module separately for the
different types of verification, you can use the result filter mentioned in Chapter 4.2. For example, if LC2 is selected, the design is displayed as Double-sided edge column, even if the design
criterion is not governing for this design.

Double-sided edge column: shear force design for LC2
In the course of the iterative calculation, the distance from the column edge to the perimeter is
determined with lw,crit = 68.40 cm.
On both sides, the perimeter lies outside of the foundation edge in the y-direction. Therefore,
the design is carried out as a shear force design.

Figure 8.59: Critical perimeter for double-sided edge column – shear force design
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The shear force VEd to be transferred is calculated as the difference between the shear force
due to compressive stress and the shear force due to surface load.

Figure 8.60: Compressive stress block and position of design section

The shear force to be transferred in the negative x-direction is:

VEd,x ,n = VD ,x ,n − VG ,x ,n = 432.43 − 274.16 = 158.27 kN
For the allowable shear stress it is first necessary to determine the mean surface reinforcement
of the bottom plate reinforcement from both directions. The longitudinal reinforcement ratio
is calculated with:

ρl =

A sl
34.848 cm2
=
= 0.515 %
d ⋅ b w 26 cm ⋅ 260 cm

The longitudinal reinforcement ratio was calculated with the reinforcement Q355 + Ø16-20 for
the bottom reinforcement in the x-direction defined in the previous paragraph.
This ratio of longitudinal reinforcement must be less than 2 %.
The safety factor CRd,c is calculated according to the following formula:

CRd,c =

0.18 0.18
=
= 0.12
γc
1.5

The scaling factor of the static depth is:

k = 1+

200
200
= 1+
= 1.877
d
260

The following applies to the design value of the shear force resistance:
1


VRd,c =  CRd,c ⋅ k ⋅ (100 ⋅ ρl ⋅ fck ) 3 + k 1 ⋅ σ cd  ⋅ b w ⋅ d ≥ VRd,c ,min


1


VRd,c =  0.12 ⋅ 1.877 ⋅ (100 ⋅ 0.0052 ⋅ 35) 3 + 0.15 ⋅ 0  ⋅ 2.6 ⋅ 0.26 = 0.3994 MN
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[1] specifies a minimum shear force resistance vmin which may lead to larger load bearing capacities in case of minor reinforcement ratios in connection with very high concrete strengths.
It is determined as follows:
1

3

3

1

v min = 0.035 ⋅ k 2 ⋅ fck2 = 0.035 ⋅1.877 2 ⋅ 35 2 = 0.5325 MPa

(

)

VRd,c ,min = p min + k 1 ⋅ σ cp ⋅ b w ⋅ d = (532.5 + 0.15 ⋅ 0 ) ⋅ 2.6 ⋅ 0.26 = 359.97 kN
Thus, the design value of the shear force resistance is larger than the minimum load bearing
capacity:

VRd,c = 399.4 kN > VRd,c ,min = 359.97 kN
So, the criterion for the shear force design from the maximum vertical force is fulfilled:

Criterion =

VEd,x ,p
VRd,c

=

158.27
= 0.396 ≤ 1
399.4

Interior column: punching shear design for LC1
In the course of the iterative calculation, the distance from the column edge to the perimeter is
determined with lw,crit = 49.0 cm. Therefore, the design is carried out as a punching shear design.

Figure 8.61: Critical perimeter for interior column – punching shear design

As the complete bucket is effective for a bucket foundation with rough bucket sides, the bucket's external dimensions are relevant for the circumference of the governing perimeter.

(

)

uit = 2 ⋅ dkx + dky + 2 ⋅ r ⋅ lw ,crit = 2 ⋅ (1.14 + 1.24 ) + 2 ⋅ 3.1416 ⋅ 0.49 = 7.839 m
Factor β:



d=
1+  k x


2

MEd,x ,sl uit   MEd,y ,sl uit 
⋅
⋅

 + ky
VEd W1,x  
VEd W1,y 

2

2

2

218.05 7.839  
144.88 7.839 

1+  0.576
1.879
=
⋅
⋅
 +  0.609
 =
226.06 5.994  
226.06 6.169 

The shear force to be transferred from the maximum vertical force is calculated with:

vEd =⋅
d

VEd
226.06
1.879 ⋅
221.2 kPa
=
=
ui ⋅ d
7.839 ⋅ 0.245

The following value is applied as the mean longitudinal reinforcement ratio:

ρl = ρ x ⋅ ρ y = 0.516 ⋅ 0.392 = 0.450
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The scaling factor of the effective depth is:

k = 1+

200
200
= 1+
= 1.904
d
245

The punching resistance without punching reinforcement is calculated as follows:
- Basic punching shear resistance according to (6.50):
1

ν Rd,c ,calc ,1 = C Rd,c ⋅ k ⋅ (100 ⋅ tl ⋅ fck ) 3 ⋅
1

0.120 ⋅ 1.904 ⋅ (100 ⋅ 0.00449 ⋅ 35) 3 ⋅

2⋅d
=
lw ,crit

2 ⋅ 0.245
= 572.3 kPa
0.490

- Minimum punching shear resistance according to [1] formula (6.50):

ν Rd,c ,calc ,2 = v min ⋅

2⋅d
lw ,crit

= 0.5438 ⋅

2 ⋅ 0.245
= 543.8 kPa
0.49

where
3

1

3

1

v min = 0.035 ⋅ k 2 ⋅ fck2 = 0.035 ⋅ 1.904 2 ⋅ 35 2 = 0.5438 MPa
Thus, the punching shear resistance is the following:

ν Rd,c = MAX(ν Rd,c ,calc ,1 ; ν Rd,c ,calc ,2 ) = MAX(572.3; 543.8 ) = 572.3 kPa
So, the design for safety against punching is fulfilled.

Criterion
=

vEd 221.2
=
= 0.387 ≤ 1
vRd,c 572.3
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8.2

Block Foundation

At last, we design a block foundation with rough bucket sides. The loading as well as the geotechnical position are the same as for the bucket foundation described in the previous example.
In this example, we do without the load determination and the geotechnical designs. Instead,
it is described how FOUNDATION Pro calculates the bucket reinforcement of the block foundation.

8.2.1

Dimensions of Foundation

Module window 2.1 Geometry manages the dimensions of the column, the foundation plate
and the bucket.

Figure 8.62: Dimensions of block foundation

8.2.2

Reinforcement in Block Foundation

8.2.2.1

Vertical Reinforcement in x-Direction

First, the number and diameter of the vertical rebars running in the x-direction are determined.
The support forces of load case LC2 are governing for the design.
The governing moment for the design is the following:

gov M y = M y + h ⋅ P = 327.00 + 0.74 ⋅ 0 = 327.00 kNm
The width of an equivalent beam is:

b = c y + h = 0.30 + 0.74 = 1.04 m
Then, the moment capacity MRd which is larger than the ultimate moment is determined.
The following table shows the parameters of the moment determination carried out in
FOUNDATION Pro.

106

Program FOUNDATION Pro © 2014 Dlubal Software GmbH

8 Examples

Figure 8.63: Moment capacity MRd,y

Thus, the required reinforcement area req As,Lvx is determined with:

req A s ,Lvx =

Fcd 453.06
=
= 10.42 cm²
fyd 43.478

We select a reinforcement of 6 Ø 16 mm with a spacing of 75 mm with As = 12.06 cm2.
In the calculation details, checking the lap length of the bucket reinforcement according to [1]
8.7.3 is activated by default. In this example, however, the check of the bucket reinforcement's lap length has been deactivated. If this option was activated in this example (see
Chapter 3.1.4, page 32), a higher percentage of reinforcement with a smaller steel diameter
would be required.

8.2.2.2

Vertical Reinforcement in y-Direction

The support forces of the load case LC3 are governing for the determination of the number
and diameter of the vertical rebars running in the y-direction.
The governing moment for the design is the following:

gov M x = M x + h ⋅ P = 150.00 + 0.724 ⋅ 0 = 150.00 kNm
The width of an equivalent beam is:

w = c x + h = 0.40 + 0.724 = 1.124 m
The following table shows the parameters used to determine the moment capacity MRd:

Figure 8.64: Moment capacity MRd,x
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Then, the required area of reinforcement req As,Lvy is determined with:

req A s ,Lvy =

Fcd 209.61
=
= 4.82 cm²
fyd 43.478

A reinforcement of 3 Ø 16 mm with a spacing of 200 mm with As = 6.03 cm2 is selected.

8.2.2.3

Horizontal Reinforcement (Shear Reinforcement for Bucket)

The required steel area of the horizontal links corresponds to the larger value of the reinforcements that has been determined for both vertical directions.
We select a reinforcement with three surrounding links of Ø 16 mm with a spacing of 200 mm
with As = 12.06 cm2.

Figure 8.65: Rendering of selected reinforcement
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